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 مقدمة 

 

 

 مقدمة: 

عدّ البرمجيات الإحصائية من الأدوات الأساسية التي يعتمد عليها الباحثون والطلبة في تحليل البيانات  
ُ
ت

الاقتصادية والمالية واتخاذ القرارات المبنية على أسس علمية دقيقة. ومع التطور المتسارع في تقنيات  

الاق العلوم  طلبة  تمكين  الضروري  من  أصبح  البيانات،  وتحليل  وعلوم  الحوسبة  والتجارية  تصادية 

تخصص   في  وخاصة  التجاريةالتسيير،  البرمجيات  العلوم  هذه  مع  التعامل  مهارات  امتلاك  من   ،

 .واستغلالها في معالجة المشكلات التطبيقية والبحثية

نهم  البرمجيات الإحصائيةيهدف مقياس  
ّ
إلى تزويد الطلبة بالمعارف النظرية والمهارات العملية التي تمك

المقياس   هذا  خلال  وسيتم  متخصصة.  برامج  باستخدام  والإحصائية  الكمية  الأساليب  تطبيق  من 

 :التركيز على برنامجين أساسيين

•  :  WinQSB  وهو برنامج موجه لتطبيقات بحوث العمليات، يتيح للطالب نمذجة وحل مختلف

البرمجة   الخطية،  البرمجة  مثل  والتجارة،  التمويل،  الإدارة،  مجالات  في  الكمية  المشكلات 

 .بالأهداف، وتحليل الشبكات وغيرها

•  :SPSS   وهو أحد أشهر البرامج في التحليل الإحصائي للبيانات، يُستخدم على نطاق واسع في

البحوث الأكاديمية والميدانية لتحليل المتغيرات، إجراء الاختبارات الإحصائية، وبناء النماذج  

 .التفسيرية والتنبؤية

و وعلوم  ة  المعتمد بكلية العلوم الاقتصادية والتجارياعداد هذه المطبوعة وفق البرنامج البيداغوجي  نم  

من خلال هذا المقياس، سيتعرّف الطالب على كيفية إدخال البيانات،    حيث  التسيير بجامعة الوادي

سياقات   في  التطبيقية  التوصيات  واستخلاص  النتائج،  تفسير  المناسبة،  التحليلية  الأدوات  اختيار 

مالية وتجارية دولية. كما يُنتظر أن يُكسبه هذا التكوين قدرة على الربط بين الجانب النظري في المناهج  

والجانب العملي   من خلال ما درسه في السنة الثانية في مقياس ي بحوث العمليات والاحصاء   ةالإحصائي

 .التطبيقي عبر البرمجيات الحديثة
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  WinQSB الفصل الأول: بحوث العمليات وتطبيقاتها باستخدام برنامج 

 تمهيد 

القرارات   بالمنافسة الشديدة ومحدودية الموارد، لم يعد اتخاذ  في عالم الأعمال الحديث الذي يتسم 

التحليل   إلى  أساس ي  بشكل  يستند  أصبح  بل  والحدس فحسب،  الخبرة  يعتمد على  الناجحة  الإدارية 

كأحد أهم الحقول   (Operations Research) بحوث العملياتالعلمي والمنهجي للبيانات. من هنا، تبرز  

المشاكل   لتحويل  الرياضية  والنماذج  الأدوات  من  قوية  بمجموعة  القرار  متخذي  تزود  التي  العلمية 

 .الحل الأمثلالمعقدة إلى نماذج كمية يمكن حلها والوصول إلى  

مقياس   في  التي درسها  الرياضية  والمعادلات  النظري  الفضاء  الطالب من  نقل  إلى  الفصل  يهدف هذا 

المطولة،   اليدوية  الحسابات  في  الغوص  من   
ً
فبدلا المباشر.  العملي  التطبيق  إلى  الكمية"  "التقنيات 

النظام الكمي  ( WinQSB سنستخدم أداة برمجية قوية ومصممة خصيصًا لهذا الغرض، وهي برنامج  

إلى "فهم الحل وتحليله"، وهو   (للأعمال سيمكننا هذا البرنامج من تحويل تركيزنا من "كيفية الحل" 

 .جوهر عملية اتخاذ القرار

سننطلق في هذا الفصل في رحلة تطبيقية منظمة، نبدأها بالأساس الذي تقوم عليه بحوث العمليات  

، لنتعلم كيفية بناء النماذج التي تهدف إلى تعظيم الأرباح أو تدنية التكاليف. بعد  البرمجة الخطيةوهو  

مثل   ومهمة  متخصصة  تطبيقات  في  سنتعمق  والتخصيصذلك،  النقل  حجر  مسائل  تعتبر  التي   ،

 .الزاوية في إدارة الخدمات اللوجستية والموارد البشرية

من خلال   المشاريع  إدارة  عالم  إلى  ننتقل  الشبكيثم  لنتعلم كيف نخطط  (PERT/CPM) التحليل   ،

ونراقب المشاريع المعقدة لضمان إنجازها في الوقت المحدد. كما سنتناول نماذج أكثر تقدمًا وواقعية  

بالأهدافمثل   ونماذج  البرمجة  متعددة،  أهداف  ذات  مشاكل  مع  تتعامل  التي  الانتظار ،    صفوف 

التنافسية من خلال   البيئات  في  القرارات الاستراتيجية  نظرية لتحليل أنظمة الخدمة، ونختتم بفهم 

 .الألعاب

إن الهدف من هذا الفصل ليس فقط تعلم كيفية "النقر" على أزرار البرنامج، بل هو تمكينك كطالب  

في تخصص المالية والتجارة الدولية من اكتساب مهارة عملية حقيقية: مهارة نمذجة المشاكل الإدارية،  

عم اتخاذ القرارات  ترجمتها إلى لغة كمية، واستخدام التكنولوجيا للوصول إلى حلول دقيقة وموثوقة تد 

 .الذكية والفعالة في أي مؤسسة اقتصادية
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 الأداة المتكاملة لدعم اتخاذ القرارات  :QSB مقدمة إلى نظام. 1 

 ؟ QSB ما هو برنامج . 1.1 

، والذي يُعرف في إصداراته الأحدث أيضًا باسم  QSB (Quantitative System for Business)برنامج  

QSOM (Quantitative Systems for Operations Management)  هو نظام برمجي متكامل مصمم ،

العمليات بحوث  وباحثي  لطلبة  تطبيقي  مختبر  بمثابة  وإدارة   (Operations Research) ليكون 

تم تطوير هذا البرنامج لسد الفجوة بين النماذج الرياضية   .(Operations Management)  العمليات

 .النظرية والتطبيق العملي في حل المشاكل الإدارية والتجارية المعقدة

اليدوية   QSB ببساطة، يقوم برنامج التي تعفينا من عناء الحسابات  "الآلة الحاسبة المتقدمة"  بدور 

الأهم الجانب  على  بالتركيز  لنا  يسمح  مما  والمعقدة،  الصحيح،  :المطولة  النموذج  بناء  المشكلة،  فهم 

 .وتحليل النتائج لاتخاذ قرارات أفضل

 ؟ QSB لماذا نستخدم برنامج . 2.1 

الشركات   فقط.  والتخمين  الحدس  على  معتمدًا  القرارات  اتخاذ  يعد  لم  اليوم،  الأعمال  عالم  في 

والمؤسسات الناجحة تعتمد على التحليل الكمي لفهم الواقع واتخاذ قرارات مبنية على بيانات وأدلة.  

 :كأداة تعليمية وتطبيقية قوية، للأسباب التالية QSB وهنا تبرز أهمية برنامج

يغطي البرنامج طيفًا واسعًا من نماذج بحوث العمليات وإدارة العمليات في  :الشمولية والتنوع .1

 إلى تحليل 
ً

مكان واحد، بدءًا من البرمجة الخطية، مرورًا بنماذج النقل والتخصيص، ووصولا

 .، وغيرها الكثير(PERT/CPM) صفوف الانتظار، نظرية الألعاب، وجدولة المشاريع

الاستخدام .2 فهمك   :سهولة  فبمجرد  ومباشرة.  بسيطة  مستخدم  بواجهة  البرنامج  يتميز 

للمشكلة وتحديد النموذج المناسب، يصبح إدخال البيانات والحصول على الحل أمرًا سريعًا  

 .لا يتطلب أي معرفة برمجية مسبقة

التحليل .3 أن  :التركيز على  أو المحلل  للطالب  يمكن  الحسابية،  للمهام  البرنامج  تولي  من خلال 

"كيف   نسأل  أن  من   
ً
فبدلا الاستراتيجي.  معناها  وفهم  النتائج  تحليل  نحو  طاقته  كل  يوجه 

كيف يمكننا استخدامها  " و "ماذا تعني هذه الأرقام؟" :نحسب؟"، نبدأ في طرح الأسئلة الأهم

 ."لتحسين الأداء؟

يعتمد البرنامج على خوارزميات رياضية دقيقة ومُختبرة، مما يضمن   :دقة وموثوقية النتائج  .4

 .أن الحلول التي يقدمها هي الحلول المثلى الممكنة بناءً على البيانات المدخلة
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من خلال تطبيقه على مجموعة من   WinQSB خلال رحلتنا في هذه المطبوعة، سنستكشف قوة برنامج

 :أهم النماذج الكمية بالترتيب التالي

الخطية .1 نتعلم  :(Linear Programming) البرمجة  حيث  العمليات،  بحوث  بأساس  نبدأ 

المتنافسة لتحقيق هدف   كيف نجد الحل الأمثل لتوزيع الموارد المحدودة على الاستخدامات 

 .معين )مثل تعظيم الربح أو تدنية التكلفة(

والتخصيص .2 النقل  حالتين   :(Transportation and Assignment) مسائل  في  نتعمق 

وكيفية   المثلى،  والشحن  التوزيع  إيجاد خطط  كيفية  لنتعلم  الخطية،  البرمجة  من  خاصتين 

 .تخصيص المهام للموارد بالكفاءة القصوى 

ننتقل إلى عالم إدارة المشاريع، حيث نستخدم أدوات قوية   :(PERT/CPM) التحليل الشبكي .3

 .لتخطيط وجدولة المشاريع المعقدة، وتحديد مسارها الحرج لضمان إنجازها في الوقت المحدد

نتعامل مع مواقف أكثر واقعية حيث يكون لدى   :(Goal Programming) البرمجة بالأهداف .4

الإدارة أهداف متعددة ومتعارضة أحيانًا، ونتعلم كيف نصل إلى الحل "الأكثر إرضاءً" الذي  

 .يحقق هذه الأهداف قدر الإمكان

الانتظار .5 ونتعلم   :(Queuing Theory) صفوف  يوميًا،  نواجهها  التي  الطوابير  ظاهرة  نحلل 

 .كيفية تصميم أنظمة الخدمة لتحقيق التوازن بين تكلفة الخدمة وتكلفة انتظار العملاء

الألعاب   .6 الاستراتيجية،   :(Game Theory)نظرية  القرارات  عالم  في  بالغوص  رحلتنا  نختتم 

 .حيث ندرس المواقف التنافسية ونحدد الاستراتيجيات المثلى التي يجب على كل طرف اتباعها

برنامج إتقان استخدام  بل سيزودك  WinQSB إن  المقياس،  في هذا  النجاح  يساعدك فقط على  لن 

واتخاذ   البيانات  تحليل  على  القدرة  أصبحت  حيث  العمل،  سوق  في  ومطلوبة  قيّمة  عملية  بمهارة 

 .القرارات المبنية عليها ميزة تنافسية أساسية

 والوصول إلى وحداته  WinQSB كيفية تشغيل برنامج. 3.1 

ه، وتشغيله والبدء في استخدامه هي عملية مباشرة تتكون من  يمببساطة تصم WinQSB يتميز برنامج 

تريد   الذي  النموذج  اختيار  وكيفية  الرئيسية  الواجهة  على  للتعرف  الدليل  هذا  اتبع  قليلة.  خطوات 

 .العمل عليه

 : تشغيل البرنامج 1الخطوة  

عادة   .(Start Menu) "على سطح المكتب أو في قائمة "ابدأ WinQSB ابحث عن أيقونة برنامج  -أ

 ."WinQSB" ما تكون الأيقونة مميزة وتحمل اسم
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 .على الأيقونة لتشغيل البرنامج (Double-click) انقر نقرًا مزدوجًا  -ب

 

 (Problem Selection Menu) : التعرف على القائمة الرئيسية2الخطوة  

هذه النافذة   .المركز الرئيس ي للبرنامج بمجرد تشغيل البرنامج، ستظهر لك مباشرة نافذة هي   -أ

 .(Problem Selection Menu) "قائمة اختيار المشاكل"تسمى 
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والنماذج الرياضية التي يمكن للبرنامج   (Modules) تحتوي هذه القائمة على جميع الوحدات -ب

 .حلها، مرتبة أبجديًا باللغة الإنجليزية

 :قائمة الوحدات التي ستظهر لك )أمثلة(

1. Decision Analysis (تحليل القرارات) 

2. Game Theory (نظرية الألعاب) - ملاحظة: قد تكون مدمجة داخل Decision Analysis 

3. Goal Programming (البرمجة بالأهداف) 

4. Linear and Integer Programming (البرمجة الخطية والصحيحة) 

5. Project Scheduling (PERT/CPM) (جدولة المشاريع) 

6. Queuing Analysis (تحليل صفوف الانتظار) 

7. Transportation Problem (مشكلة النقل) 

 التي تريد العمل عليها  (Module) : اختيار الوحدة3الخطوة  

لتحديد الوحدة التي تتوافق مع الدرس الحالي، ابحث عن اسمها في القائمة. على سبيل المثال،   -أ

عن   سنبحث  الخطية،  البرمجة  في  مسألة  حل  نريد  كنا   Linear and Integerإذا 

Programming. 

على اسم الوحدة التي تريدها، أو انقر عليها مرة واحدة لتحديدها ثم اضغط   انقر نقرًا مزدوجًا -ب

 .OKعلى زر 
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 (New Problem) : إنشاء ملف مشكلة جديد4الخطوة  

بعد اختيار الوحدة، ستنتقل إلى شاشة جديدة خاصة بهذه الوحدة. أول ما عليك فعله هو   -أ

 .إنشاء ملف جديد لمشكلتك

  Fileاذهب إلى القائمة العلوية واختر  -ب

 يدة (مشكلة جد New Problem( من القائمة المنسدلة، اختر  -ت

 

 : إدخال البيانات الأولية للمشكلة 5الخطوة  

هذه المعلومات   .المعلومات الأساسية للمشكلةستظهر لك نافذة منبثقة تطلب منك إدخال   -أ

 
ً
 :تختلف باختلاف الوحدة، ولكنها تشمل عادة

a. المشكلة تعظيم   لإعطاء  (Problem Title ): عنوان  "مشكلة  )مثال:  لمسألتك  اسم 

 .الأرباح"(

b. مثل عدد المتغيرات وعدد القيود في البرمجة الخطية، أو عدد المصادر  :أبعاد المشكلة

 .والوجهات في مشكلة النقل

c. الهدف (Objective): تعظيم تحديد ما إذا كنت تريد (Maximization) تدنية أو 

(Minimization). 

 .OKاملأ هذه البيانات بعناية ثم اضغط  -ب
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 : إدخال البيانات التفصيلية والحل 6الخطوة  

الرئيسية، حيث يمكنك   مصفوفة إدخال البيانات ، ستظهر لكOK بعد الضغط على -أ

إدخال جميع الأرقام والمعاملات الخاصة بمشكلتك )معاملات دالة الهدف، معاملات القيود، 

 .إلخ(

 Solve بعد التأكد من إدخال جميع البيانات بشكل صحيح، اذهب إلى القائمة العلوية واختر -ب

and Analyze  ثم اخترحل وتحليل ، Solve the Problem  حل المشكلة. 

 .سيقوم البرنامج بعرض النتائج النهائية في جدول مفصل -ت

، وإدخال بيانات أي   WinQSB بهذه الخطوات البسيطة، يمكنك التنقل بين جميع وحدات برنامج

 .مشكلة، والحصول على الحل الأمثل بكفاءة وسرعة

 (Linear Programming) البرمجة الخطية. 2 

هي واحدة من أقوى وأشهر أدوات بحوث العمليات،   (Linear Programming - LP) البرمجة الخطية

الأمثل  الحل  يُستخدم لإيجاد  في ظل وجود   (Optimal Solution) وهي أسلوب رياض ي  معينة  لمشكلة 

ش يء مرغوب فيه )مثل   (Maximization) قيود أو موارد محدودة. كلمة "الأمثل" هنا تعني إما تعظيم

 .ش يء غير مرغوب فيه )مثل التكاليف أو الوقت( (Minimization) الأرباح أو الإنتاج(، أو تدنية 

سمى "خطية" لأن جميع العلاقات الرياضية في النموذج )دالة الهدف والقيود( هي علاقات خطية، أي  
ُ
ت

 ( .(X1*X2 مثل أو مضروبة في بعضها البعض (X²) مثل لا تحتوي على متغيرات مرفوعة لأسس
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 :المكونات الأساسية لنموذج البرمجة الخطية. 1.2 

القرار • في   :(Decision Variables) متغيرات  التي نريد تحديد قيمتها.  العناصر المجهولة  هي 

 .(X1, X2) مثالنا، هي كمية الإنتاج من كل منتج 

الهدف • نسعى   :(Objective Function) دالة  الذي  الهدف  عن  تعبر  رياضية  معادلة  هي 

 .لتحقيقه )تعظيم الربح أو تدنية التكلفة( بدلالة متغيرات القرار

هي مجموعة من المتباينات أو المعادلات التي تعبر عن محدودية الموارد   :(Constraints) القيود •

الممكنة   القيم  من  تحد  القيود  هذه  الميزانية(.  الخام،  المواد  العمل،  ساعات  )مثل  المتاحة 

 .لمتغيرات القرار

هو شرط أساس ي يفترض أن متغيرات    (:Non-negativity Constraintقيد عدم السلبية ) •

 القرار لا يمكن أن تكون سالبة )فلا يمكن إنتاج كمية سالبة من منتج ما(. 

 تطبيقي:  مثال. 2.2 

اذا كان لدينا لدينا الانموذج الرياض ي لأحدى الشركات الصناعية لانتاج المواد الكيمياوية بالشكل  

 الآتي: 

• Maximize Z= 50X
1
 +60X

2
  

• Subject to 

• 2X
1
 +3X

2
 <= 180 

• 3X
1
 + 2X

2
 <= 150 

• X
1 ;

X
2
 >=0 

 

 حيث أن: •

• 2 X; 1X يمثلان منتجات الشركة 

 يمثلان أرباح المنتجين 50،  60 •

 يمثلان الموارد المتاحة 150، 180 •

 المطلوب :   •

 أوجد الحل الأمثل ) بطريقة الرسم وبطريقة السمبلكس( •

 : QSBباستخدام برنامج  الحلخطوات 
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 : تشغيل البرنامج واختيار الوحدة المناسبة1الخطوة  -أ

 QSB افتح برنامج -ب

   Linear and Integer Programming  من القائمة الرئيسية، ابحث عن وحدة -ت

 

 

 New problemنختار  Fileمن  -ث

 
 : تسمية المشكلة وتحديد أبعادها2الخطوة 

 :في نافذة إدخال البيانات الأولية -أ

Problem Title  -  كتابة عنوان للمسألة في حقل   

.Number of Variables  - كتابة عدد المتغيرات في المسألة في حقل  

.Number of Constraint  كتابة عدد القيود في المسألة في حقل-  

.Objective Criterion في حقل " Max or Min "   اختيار نوع دالة الهدف - 
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Spreadsheet Matrix Form  - نختار لإدخال المسألة على صيغة المصفوفات    

حقل  اختيار نوع المتغيرات إذا هي صحيحة أو مستمرة أو ثنائية أم غير مقيدة بإشارة في - Defaulte 

Variable Type   

.OK  - نضغط على حقل   

 

 وحفظها  : إدخال بيانات المشكلة3الخطوة 

 .ستظهر لك الآن شاشة إدخال البيانات على شكل جدول 

 نقوم بادخال قيود المسألة  -أ

 
ثم نقوم بتسمية المسألة ونختار   File → Save Problem Asحفظ المسألة من خلال الامر  -ب

 okمكان الحفظ ونضغط على 
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 حل المسألة :  4الخطوة 

 :بعد إدخال وحفظ المسألة يتم حل المسألة باتباع الخطوات الآتية

 .لحل المسألة نختار قائمة  •

Solve and Analyze         Solve the problem 
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 ليظهر جدول الحل النهائي كما في الشكل الموالي:   •

لأن المسألة تتضمن   Solve and Analysis→ 𝐺𝑟𝑎𝑝ℎ𝑖𝑐لحل المسألة بيانيا نتبع المسار  •

 .متغيرين فقط
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 التقرير "تحليل النتائج"  -أ

 :خطة الإنتاج المثالية للشركة هي كالآتي

وحدة من المنتج الثاني بحيث تحقق إجمالي أرباح    48وحدة من المنتج الأول و  18تنتج  •

  :وحدة نقدية وفقا للعلاقة 3780

𝑍(18,48) = 2(18) + 3(48) = 3780 

 33.3333وحدة وقيم ،المنتج الثاني بين   90و   40ويبقى الحل أمثلا إذا كانت قيم المنتج الأول بين 

 .وحدة 75و 

 في الحل الأمثل أكبر من الصفر.     X1 .X2 أما التكلفة المخفضة فتساوي الصفر لأن قيمة •

 18،15(، أي عند زيادة الموارد المتاحة ب:  6،16في حين أن أسعار الظل هي على التوالي)  •

 .( على التوالي6،16) بـ:الهدف "الأرباح" ستزداد   وحدة واحدة فإن دالة 

 WINQSBمسائل النقل والتخصيص في برنامج  . 3 

 Transportation problemمشكلة النقل . 1.3 

مشكلة النقل هي حالة خاصة من مشاكل البرمجة الخطية، وتهدف إلى إيجاد الخطة المثلى لنقل كميات  

من سلعة معينة من عدة مصادر )مراكز توريد أو مصانع( إلى عدة وجهات )مراكز استهلاك أو أسواق(  

 .بأقل تكلفة إجمالية ممكنة

 النقلعناصر مشكلة .  1.1.3

الأماكن التي تتوفر فيها السلعة )المصانع( لكل مركز طاقة إنتاجية   :(Sources) مراكز التوريد -أ

 .(Supply) أو كمية معروضة محددة

الأماكن التي تطلب السلعة )الأسواق( لكل مركز حجم  :(Destinations) مراكز الاستهلاك -ب

 .(Demand) طلب أو كمية مطلوبة محددة

تكلفة نقل وحدة واحدة من السلعة من كل مركز توريد إلى كل  :(Unit Cost) تكلفة النقل -ت

 .مركز استهلاك

تلبية    الهدف: -ث يتم  بحيث  وجهة،  كل  إلى  مصدر  كل  من  نقلها  يجب  التي  الكميات  تحديد 

 احتياجات مراكز الاستهلاك دون تجاوز طاقة مراكز التوريد، وبأقل تكلفة نقل إجمالية.
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 مثال تطبيقي 

أوجد حلا لمسألة النقل التالية والتي تكون من ثلاثة مراكز استهلاك وثلاثة مراكز توريد والبيانات التالية  

 : الخاصة بالطاقات وبتكاليف النقل بين هذه المراكز

 طاقة مراكز التوريد  مراكز الاستهلاك  مراكز التوريد 

1 2 3 

A 6 8 10 150 

B 7 11 11 175 

C 4 5 12 275 

 300 100 200 حجم الطلب من مراكز الاستهلاك
 

 

  QSB خطوات الحل باستخدام برنامج  •

 : تشغيل البرنامج واختيار الوحدة المناسبة1الخطوة 

 QSB افتح برنامج -أ

  Network Modeling   من القائمة الرئيسية، ابحث عن وحدة -ب

 New problemنختار  Fileمن  -ت

 : تسمية المشكلة وتحديد أبعادها2الخطوة 

 :في نافذة إدخال البيانات الأولية -ب

a.  Problem Title اكتب اسمًا للمشكلة، مثل "مشكلة_النقل :(عنوان المشكلة". ) 

b.  Number of Sources عدد المصادر:  (A, B, C)  3أدخل 

c. Number of Destinations  :3أدخل   (3 ,2 ,1)  عدد الوجهات 

d.  Objective Criterion الهدف اختيار :(معيار  من    تدنية  ) Minimization تأكد 

 .لأننا نريد تقليل التكاليف

 .OK اضغط -ت
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 : إدخال بيانات المشكلة3الخطوة 

 .ستظهر لك الآن شاشة إدخال البيانات على شكل جدول 

في الجزء الرئيس ي من الجدول، أدخل تكاليف النقل لكل مسار كما هي   :إدخال تكاليف النقل -أ

 .موضحة في المثال

 في العمود الأيمن المخصص للعرض، أدخل طاقة كل مركز توريد :(Supply) إدخال العرض -ب

(150, 175, 275). 

في الصف السفلي المخصص للطلب، أدخل حجم طلب كل مركز   :(Demand) إدخال الطلب -ت

 .(300 ,100 ,200) استهلاك

 :صورة توضيحية لشاشة إدخال البيانات

 

 : حل المشكلة وعرض النتائج4الخطوة 

                بعد إدخال جميع البيانات بشكل صحيح، اذهب إلى القائمة العلوية واختر -أ

Solve and  Analyze → Solve the Problem 
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 كما في الجدول التالي: سيقوم البرنامج فورًا بإيجاد الحل الأمثل وعرضه -ب

 

 :تحليل وتفسير خطة النقل المثلى •

الجدول يوضح لنا بالضبط الكمية التي يجب شحنها من كل مصدر إلى كل وجهة   :خطة التوزيع -أ

 :لتحقيق أقل تكلفة

 :A من مركز التوريد •

a. 1 إلى مركز الاستهلاك وحدة 25 يتم شحن 

b. 3 إلى مركز الاستهلاك وحدة 125 يتم شحن. 

c. ) من الشحنات  طاقته  A = 125 + 25 = 150 إجمالي  يطابق  وهو   ،

 )الإنتاجية

 :B من مركز التوريد •

a. 3 بالكامل إلى مركز الاستهلاك وحدة 175 يتم شحن. 

b. (إجمالي الشحنات من B = 175وهو يطابق طاقته الإنتاجية ،) 

 :C من مركز التوريد •

a. 1 إلى مركز الاستهلاك وحدة 175 يتم شحن. 

b. 2 إلى مركز الاستهلاك وحدة 100 يتم شحن 

 )، وهو يطابق طاقته الإنتاجيةC = 175 + 100 = 275 إجمالي الشحنات من( •

 :التكلفة الإجمالية المثلى -ب

 Total Cost = 4525 :  النتيجة النهائية

أقل تكلفة إجمالية ممكنة لنقل جميع البضائع وتلبية جميع الطلبات وفقًا للبيانات المتاحة   :التفسير

 .وحدة نقدية. أي خطة توزيع أخرى ستؤدي إلى تكلفة إجمالية أعلى 4525  هي

 : الاستنتاج العام للتحليل •

باستخدام نموذج النقل، تمكنا من تحديد خطة الشحن المثلى التي تضمن تدفق البضائع من المصادر  

إلى الوجهات بكفاءة عالية وبأقل تكلفة ممكنة. هذا الحل يوفر للشركة أساسًا علميًا لاتخاذ قراراتها  

 .اللوجستية، مما يؤدي إلى توفير كبير في التكاليف التشغيلية
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 (Assignment Problem) مشكلة التخصيص. 2.3 

مشكلة التخصيص هي حالة خاصة جدًا من مشكلة النقل، وتهدف إلى إيجاد أفضل طريقة لتخصيص  

"المهام من  "العناصر (Tasks) "مجموعة  من  يتم   (Agents) "لمجموعة  الآلات.  أو  الموظفين  مثل 

على أساس   لواحد  التخصيص  لعنصر  (one-to-one) واحد  يتم تخصيصها  كل مهمة  أن  بمعنى   ،

 .واحد فقط، وكل عنصر يتم تخصيصه لمهمة واحدة فقط

 :، والتي قد تكون أفضل نتيجة إجماليةالهدف هو إيجاد خطة التخصيص التي تحقق  

مثل تقليل إجمالي الوقت اللازم لإنجاز جميع المهام، أو تقليل  :(Minimization) تدنية •

 .إجمالي التكاليف

مثل زيادة إجمالي الأرباح الناتجة عن التخصيص، أو زيادة   :(Maximization) تعظيم •

 .إجمالي نقاط الجودة

 مثال تطبيقي  

 تخصيص مهندسين لمشاريع

شركة استشارات هندسية لديها أربعة مهندسين )أحمد، بدر، خالد، داود( وتريد تخصيص كل واحد  

 .(4، مشروع 3، مشروع  2، مشروع 1منهم لمشروع واحد فقط من بين أربعة مشاريع متاحة )مشروع 

قام مدير الشركة بتقدير الوقت اللازم )بالأيام( الذي سيستغرقه كل مهندس لإنجاز كل مشروع، بناءً  

 .على خبرته وتخصصه. هذه التقديرات موضحة في الجدول التالي

 جدول بيانات المشكلة )الوقت بالأيام(: 

 4مشروع 3مشروع 2مشروع 1مشروع 

 11 19 12 10 أحمد 

 8 7 10 5 بدر 

 11 13 14 12 خالد 

 9 11 15 8 داود

  :المطلوب

 .إيجاد خطة التخصيص المثلى التي تضمن إنجاز جميع المشاريع في أقل إجمالي وقت ممكن
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 QSB خطوات الحل باستخدام برنامج 

 : تشغيل البرنامج واختيار الوحدة المناسبة1الخطوة 

 .QSB افتح برنامج -أ

  Network Modeling   من القائمة الرئيسية، ابحث عن وحدة -ب

 New problemنختار  Fileمن  -ت

 : تسمية المشكلة وتحديد أبعادها2الخطوة 

 :في نافذة إدخال البيانات الأولية -أ

a. Problem Title تخصيص_المهندسين لمث اكتب اسمًا للمشكلة، ة :عنوان المشكل"". 

b. Number of sources/agents  المهندسون  4 :أدخل :عدد المصادر/العناصر 

c. Number of destinations/tasks   :المشاريع  4عدد الوجهات/المهام: أدخل 

d.  Objective Criterion   اختيار  تأكد من :معيار الهدف      )Minimizationتدنية) ،

 .لأننا نريد تقليل إجمالي الوقت

 OK على  اضغط -ب

 
 : إدخال بيانات المشكلة3الخطوة 

 .ستظهر لك الآن شاشة إدخال البيانات على شكل مصفوفة -أ
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في هذا الجدول، أدخل قيم الوقت اللازم لكل مهندس لإنجاز كل مشروع، كما هي موضحة في  -ب

 (Tasks) بأسماء المهندسين والأعمدة (Agents) المثال. يمكنك أيضًا إعادة تسمية الصفوف

 .بأسماء المشاريع لتسهيل القراءة

 

 : حل المشكلة وعرض النتائج4الخطوة 

 :بعد إدخال جميع البيانات بشكل صحيح، اذهب إلى القائمة العلوية واختر

 Solve and Analyze → Solve the Problem 

 

 :تحليل وتفسير خطة التخصيص المثلى •

ف بأي مشروع لتحقيق   :خطة التخصيصأ. 
ّ
الجدول يوضح لنا بالضبط أي مهندس يجب أن يُكل

 :أقل إجمالي وقت عمل

 ( يومًا 12سيستغرق ) 2مشروع  يتم تخصيصه لـ أحمد •

 .(أيام 7سيستغرق ) 3مشروع  يتم تخصيصه لـ بدر •

 .(يومًا 11سيستغرق ) 4مشروع  يتم تخصيصه لـ خالد •

 .(أيام 8سيستغرق ) 1مشروع  يتم تخصيصه لـ داود •

 :ملاحظات هامة

 .كل مهندس تم تخصيصه لمشروع واحد فقط •

 .كل مشروع تم تخصيصه لمهندس واحد فقط •

 .تم استغلال جميع الموارد )المهندسين( وإنجاز جميع المهام )المشاريع( •

 :إجمالي الوقت الأمثل ب.
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    Total Cost (Time) = 38 :النتيجة النهائية •

أي خطة  .يوم عمل 38 أقل إجمالي وقت ممكن لإنجاز جميع المشاريع الأربعة هو :التفسير •

 من داود( ستؤدي   1تخصيص أخرى )على سبيل المثال، لو قمنا بتكليف بدر بالمشروع 
ً
بدلا

 .يومًا 38إلى إجمالي وقت عمل أطول من 

 :الاستنتاج العام للتحليل ج.

باستخدام نموذج التخصيص، تمكنت إدارة الشركة من تجاوز الحيرة في توزيع المهام، والوصول إلى  

خطة عمل علمية ومثلى. هذا الحل يضمن توزيع المهندسين على المشاريع بالطريقة الأكثر كفاءة، مما  

 يوفر وقت الشركة ومواردها ويضمن إنجاز المشاريع في أقصر مدة إجمالية ممكنة 

 الشبكي  التحليل. 4 

 CRUTICAL PATH METHOD أسلوب المسار الحرج  . 1.4 

هو من الأساليب المهمة في إدارة المشاريع حيث يستخدم عادة في إيجاد العلاقة بين الكلفة   •

 الكلية ووقت التنفيذ. 

أسلوب المسار الحرج يستخدم للتعامل مع الأوقات الثابتة أي الأوقات المحددة بعناية وفيها   •

 نسبة خطأ قليلة جدا 

 مثال تطبيقي  

 البيانات تمثل نشاطات انشاء مبنى معين وكذلك الأوقات )يوم( والتكاليف )الدولار( 

 النشاط  النشاط السابق  الوقت الطبيعي  الوقت المعجل  الكلفة الطبيعية  الكلفة المعجلة 

2.5 2 3 5 - A 

3 3 4 4 - B 

5 4 7 8 - C 

1.5 1.2 2 3 A D 

3 2 5 7 A E 

3 3 5 5 C F 

3.7 3 3 4 C G 
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8 8 3 3 B.D H 

1600 700 6 9 F.H I 

2 1.5 7 11 F.H J 

1500 600 6 8 E.I K 

1.05 1 9 10 G.J L 

 

 المطلوب: 

 إيجاد:  QSBبواسطة برنامج 

 الزمن والكلفة الكلية للمشروع بالوقت الطبيعي  .1

 الزمن والكلفة الكلية للمشروع بالوقت المعجل .2

 يوم  31إيجاد الكلفة الكلية لاكمال المشروع في  .3

 يوم 29إيجاد احتمالية اكمال المشروع في  .4

 إيجاد المسار الحرج  .5

 QSBخطوات الحل باستخدام برنامج 

 تشغيل البرنامج واختيار الوحدة المناسبة :1الخطوة 

   QSB افتح برنامج -أ

 PERT_CPM  من القائمة الرئيسية، ابحث عن وحدة -ب

 : تسمية المشكلة وتحديد أبعادها2الخطوة 

 New Problem ← Fileلإدخال بيانات المسألة نتبع المسار 
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 يفتح لنا مربع الحوار الموضح في الشكل الموالي نقوم بإدخال خصائص المشكلة 

 

   Problem Titleكتابة عنوان للمسألة في حقل  •

 Number of Activitiesكتابة عدد الأنشطة في حقل  •

 Time Unitكتابة وحدة الوقت في  •

وإذا كان وقت متفائل   CPMاختيار نوع المشكلة أذا كان وقت طبيعي ووقت معجل أختار  •

 PERTووقت متشائم أختار  

 لإدخال المسألة على صيغة المصفوفات.  Spreadsheet Matrix Formنختار   •

 :   Slect CPM Data Fieldونختار من حقل  •

 Normal Time  الوقت الطبيعي 

 Crash Time الوقت المعجل 

 Normal Cost الكلفة الطبيعية 

 Crash Cost  الكلفة المعجلة 

 OKنضغط على  •

 : ادخال بيانات المشكلة3الخطوة 

 يظهر لنا جدول على الشاشة نقوم بملئ البيانات كما هي موضحة في الشكل الموالي: 
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 : حفظ المسألة:4الخطوة 

 : نقوم بحفظ المسألة باتباع المسار 

File → Save Problem As   

 okنقوم بتسمية المسألة ونختار مكان الحفظ ونضغط على و 

 

 شكلة وعرض النتائجحل الم:  5الخطوة 

 بالكلفة والوقت الطبيعي:  -1

 وذلك باتباع المسار:

 Solve and Analyse         Solve Critical Path Using Normal Time  
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 فيظهر لنا الحل في الجدول الموالي:

 

 يوم  34من خلال الجدول يظهر أن المشروع بالوقت الطبيعي سيستغرق 

 دولار 1328.70أما التكلفة الكلية للمشروع فسوف تكون 

 بالكلفة والوقت المعجل:  -2

 :وذلك باتباع المسار

 Solve and Analyse           Solve Critical Path Using Crash Time 

 

 فيظهر لنا الحل في الجدول التالي:
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 يوم  28من خلال الجدول يظهر أن المشروع بالوقت المعجل سيستغرق 

 دولار 3132.75أما التكلفة الكلية للمشروع فسوف تكون  

 يوم  31إيجاد الكلفة الكلية لاكمال المشروع في  -3

 وذلك باتباع المسار:  

Results            Perform Crashing Analysis 

 كما هو موضح في الشكل الموالي

 

 فتظهر لنا النافذة التالية: 
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يوم ثم  31الوقت المحدد في السؤال وهو   Dsined completion timeنكتب في الخانة 

 فيظهر لنا الجدول التالي:  OKنضغط على 

 

 دولار 1328.70يوم هي:   31من خلال الجدول نلاحظ أن الكلفة الكلية لإكمال المشروع في 

 يوم:  29إيجاد احتمالية اكمال المشروع في   -4

  :وذلك باتباع المسار

Results             Project Completion  Analysis 

 :كما هو موضح في الشكل الموالي
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 عند الضغط على هذا الأمر تظهر الواجهة التالية:  •

 

كما موضحة في الشكل أعلاه   29نقوم بكتابة عدد الأيام المحتمل أن يكتمل فيها المشروع وهي  •

 فيظهر الحل في الجدول التالي: OKونضغط على 

 



 د. باهي وف اء   WinQSB الفصل الأول: بحوث العمليات وتطبيق اتها باستخدام برنامج 

28 

 

 .% 85.2941يوم هي  29من خلال الجدول نجد أن احتمالية إنهاء المشروع خلال  

 إيجاد المسار الحرج:  -5

 : من خلال المسار 

Results              Show Critical Path 

 كما في الشكل التالي:

 

          بمجرد الضغط على هذا الأمر يعطينا البرنامج الشكل التالي: •

 

 من خلال الشكل يتضح بأن المسار الحرج الخاص بالوقت   •

 الطبيعي هو: 

   C            F         J            L      
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 QSBالبرمجة بالأهداف في برنامج  . 5 

 برمجة الأهداف . 1.5 

احدى أهم أساليب بحوث العمليات حيث تطبق في حالة وجد أكثر من هدف يتطلب تحقيقه حيث  

 تختلف عن البرمجة الخطية من خلال: 

من  -أ العديد  على  تحتوي  الأهداف  برمجة  لكن  واحد  هدف  فقط  تتضمن  الخطية  البرمجة 

 الهداف التي يتطلب تحقيقها

في حين برمجة الهداف دائما الدالة عبارة عن    minأو    maxدالة الهدف في البرمجة الخطية إما   -ب

   min Zتقليل الانحرافات 

في البرمجة الخطية لا توجد أولوية لتحقيق الهدف لأنه هدف واحد في حين برمجة الأهداف   -ت

 توجد أولوية لتحقيق الأهداف

 خطوات صياغة برمجة الأهداف . 2.5 

 يتطلب اتباع الخطوات التالية لصياغة وحل مسائل برمجة الأهداف وهي:

 ..…,x1,x2,x3صياغة المتغيرات الساسية ويرمز لها بالرمز  -أ

   piوالانحرافات العليا يرمز لها  niصياغة الانحرافات وهي انحرافات الحدود الدنيا ويرمز لها  -ب

يقصد بالانحرافات هي الانحرافات عن تحقيق الهدف مثلا لو كان الهدف هو تحقيق لا يقل عن  

دولار    500دولار ربح فانه يتطلب تقليل الانحراف الأدنى أي في هذه الحالة فإنه يجب أن نحقق    500

ذه الحالة  وحدة فإنه في ه  300أو أكثر وإذا كان الهدف مثلا تحقيق انتاج من منتج معين لا يزيد عن  

وحدة فإنه في    400وفي حالة إذا كان يتطلب أن نحقق مبيعات   piيجب تقليل الانحراف الأعلى أي  

 هذه الحالة تقليل الانحراف الأعلى والأدنى معا. 

 صياغة الأهداف مثلا لو كان يتطلب تحقيق الأهداف أعلاه فان صياغة الأهداف ستكون:  -أ

a. Min Z = n1 

b. Min Z = p2 

c. Min Z =n3 + p3 

 صياغة القيود حيث تتضمن القيود مجموعة من قيود الأهداف وقيود المسألة الأساسية.  -ب
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 مثال تطبيقي  

حيث    1Mوالتي يعتمد على انتاجهما على المواد الأولية من نوع   B , A شركة تنتج نوعين من المنتجات 

 B وحدات من هذه المادة في حين  4يحتاج الى   A وحدة . كل وحدة واحدة من انتاج المنتج  120يتوفر  

  . وحدات  6يحتاج الى 

عامل في حين   A 4.5 عامل يعمل في هذه الشركة حيث يتطلب لصناعة وحدة واحدة من المنتج120 

  B  عمال لإنتاج وحدة واحدة من المنتج 6نحتاج الى 

 دولار على التوالي  35دولار و  30هي  B , A ربح الوحدة الواحدة من المنتجين

 الاهداف:  

 دولار700تحقيق ربح لا يقل عن  1- 

 وحدات 10يقل عن  لا   A تحقيق انتاج من المنتج 2- 

 عامل  100تحقيق باستخدام لا يزيد عن  3- 

 المطلوب  

 صياغة المسالة باستخدام برمجة الاهداف   1-

 QSB  اكتب كافة الخطوات لادخال هذه المسالة الى نظام 2-

 فسر نتائج الحل الأمثل 3-

 ول الا جواب الفرع  :- الحل

 صياغة المتغيرات  1-  

  X1عدد الوحدات من المنتج A  

X2  عدد الوحدات من المنتج B  

 صياغة المسالة الأساسية هي اي بدون الاهداف الثلاثة 

 Max Z = 30 X1 + 35X2  

S T 
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 4X1 + 6X2 ≤ 100 

 4.5X1 + 5X2 ≤ 120 

 X1 , X2 ≥ 0 

 صياغة قيود الأهداف حسب السؤال 

 في هذه الحالة يتم اضافة لكل هدف متغيرات الحد الادنى ناقص الحد الاعلى  

 30X1 + 35X2 + n1 - p1 = 700 

 X1                   +n2 - p2 =10    

 4.5 X1 +5X2 + n3 - p3 = 100 

 صياغة دالة الهدف 

 حسب هذا السؤال يوجد لدينا ثلاثة اهداف وهي   

  n1دولار ففي هذه الحالة يتم تقليل   700تحقيق ربح لا يقل عن  •

   10لا يقل عن  A تحقيق انتاج من المنتج •

 عامل  100يزيد عن  لاتحقيق باستخدام   •

 Min Z = n1  

 Min Z = n 

Min Z = p3 

 تنظيم المسالة وكالآتي:

Min G1 = n1 

 Min G2 = n2 

 Min G3 = p3 

 ST 

4X1 + 6X2 ≤ 100  

4.5X1 + 5X2 ≤ 120 
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30X1 + 35X2 + n1 - p1 = 700  

X1               +n2 - p2 = 10 

4.5 X1 +5X2 + n3 - p3 = 100 

x1,x2,n1,p1,n2,p2,n3,p3 ≥ 0 

 :QSB ادخال المسألة في برنامج 

 يتم تشغيل النظام  -1

  Goal Programmingاختيار الأسلوب   -2

 Fileمن الامر  New Problemتفتح لنا نافذة حيث يتم اختيار   -3

 تظهر لنا نافذة ادخال خصائص المشكلة كما في الشكل ادناه:  -4

 

 goal 1ولتكن   problem titleنكتب اسم المشكلة في خانة   •

 3عدد الأهداف حيث حسب السؤال    number of goalsفي خانة   •

 8عدد المتغيرات وحسب السؤال=  number of variablesفي خانة  •

 5عدد القيود وهي  number of constraintsفي خانة  •

 minimizationنضلل حسب اهداف السؤال  •

 nonnegative continuousنضلل حسب السؤال  •
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 فيظهر لنا جدول ادخال البيانات كما في الجدول التالي   okنضغط على  -5

حسب المتغيرات الانحراف وحسب الصياغة في السؤال أي    x8الى    x3يتم تغيير المتغيرات من   -6

ب:   المتغيرات  هذه  استبدال  الامر   n1,n2,p1,p2,n3,p3يتم  خلال  من  ذلك   variableويتم 

name    من الامرedit :كما في الشكل التالي 
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 يتم ادخال بيانات المسألة في جدول البيانات كما في الشكل التالي: -7

 solve and analysisمن الامر   solve the problemبعد ذلك نختار الامر   -8

 okنضغط على  -9

 يتم حل المسألة من قبل النظام ويظهر لنا جدول الحل الأمثل التالي:  -10
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 : تفسير الحل الامثل 

• X1 = 17.5 

• X2= 5 

 قيمة الاهداف هي   

G1=0   اي تم تحقيق الهدف الاول 

 G2=0 اي تم تحقيق الهدف الثاني 

 G3=3.75 3,75 لم يتم تحقيق الهدف الثالث حيث يوجد انحراف قدرة   

 Theory Queuing نظریة صفوف الانتظار. 6 

 تعريف صفوف الانتظار . 1.6 

المصارف،   في  نراها  اليومية،  حياتنا  من  يتجزأ  لا  جزءًا  الطوابير(  )أو  الانتظار  صفوف  تعتبر 

هي فرع من بحوث    نظرية صفوف الانتظار .المستشفيات، مراكز الاتصال، وحتى في أنظمة الكمبيوتر

 .العمليات يستخدم النماذج الرياضية لتحليل هذه الطوابير بهدف فهم أدائها وتحسينه

لتقليل   الموظفين  من  المزيد  توظيف  )مثل  الخدمة  تقديم  تكلفة  بين  الموازنة  هو  الأساس ي  الهدف 

 .الانتظار( وتكلفة الانتظار نفسها )مثل خسارة الزبائن بسبب الانتظار الطويل(

 مكونات نظام الانتظار. 2.6 

 :يتكون أي نظام انتظار من مكونين أساسيين

متوسط عدد الزبائن الذين يصلون إلى النظام خلال  :(Arrival Rate - λ) معدل الوصول  -أ

 .فترة زمنية معينة

الخدمة -ب الخدمة   :(Service Rate - μ) معدل  لمقدم  يمكن  الذين  الزبائن  عدد  متوسط 

 .)الخادم( خدمتهم خلال نفس الفترة الزمنية

 تحليل صفوف الانتظار في مصرف  :مثال تطبيقي 

يقدم مصرف خدمة للزبائن من خلال نافذة خدمة واحدة. تشير البيانات إلى أن معدل خدمة الموظف  

ا في الساعة 150هو 
ً
ا في الساعة 140، بينما يصل الزبائن إلى المصرف بمعدل زبون

ً
 .زبون
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 :المعطيات الأساسية

 .زبون/ساعة 140 :(λ)  معدل الوصول  •

 .زبون/ساعة 150 :(μ)  معدل الخدمة •

 لأننا نتحدث عن نافذة خدمة واحدة أو موظف واحد   1 :(s) عدد الخوادم •

 :، أوجد مقاييس الأداء الرئيسية التالية للنظامQSB باستخدام برنامج :المطلوب

1.  
ً
 .احتمال أن يكون المصرف )الموظف( مشغولا

 .متوسط عدد الزبائن المتوقع في صف الانتظار )الطابور( .2

 .متوسط عدد الزبائن المتوقع في النظام )الطابور + من يتلقى الخدمة( .3

 .متوسط وقت الانتظار للزبون المتوقع في النظام .4

 .متوسط وقت الانتظار للزبون في الصف .5

  QSB   خطوات الحل باستخدام برنامج 

 : تشغيل البرنامج واختيار النموذج المناسب 1الخطوة 

 QSB افتح برنامج -أ

 تحليل صفوف الانتظار  "Queuing Analysis" من القائمة الرئيسية، اختر -ب
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أو   "Bank_Problem" سيطلب منك البرنامج تحديد اسم للمشكلة الجديدة، يمكنك تسميتها -ت

 .OK "مشكلة_المصرف"، ثم اضغط

 : إدخال بيانات المشكلة2الخطوة 

 .، ستظهر لك شاشة إدخال البيانات الرئيسيةOK بعد الضغط على -أ

هي -ب خطوة  وأهم  النموذج  أول  نوع  )وصول   .(Model Type) تحديد  معطياتنا  على  بناءً 

هو المناسب  النموذج  فإن  واحد(،  خادم  عشوائية،  خدمة   M/M/s (Poisson :عشوائي، 

arrival, Exponential service) اختر هذا النموذج من القائمة المنسدلة. 

 :الآن، قم بإدخال المعطيات التي حددناها سابقًا -ت

a.  Number of servers (s): 1أدخل  

b. Arrival rate (lambda):  140 أدخل  

c. Service rate (mu):  150 أدخل  

 "per hour" في حالتنا، كلاهما( تأكد من أن وحدات الزمن لمعدل الوصول والخدمة متطابقة -ث

 .، وهذا شرط أساس ي لصحة الحل(أو بالساعة

 

 : حل المشكلة وعرض النتائج3الخطوة 

 ربعد إدخال البيانات بشكل صحيح، اذهب إلى القائمة العلوية واخت -أ

Solve and Analyze → Solve:  the Problem 
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 .سيقوم البرنامج فورًا بحل النموذج الرياض ي وعرض النتائج في جدول شامل -ب

 :الإجابة على أسئلة المثال بالتفصيل •

؟  .1
ً
 احتمال أن يكون المصرف )الموظف( مشغولا

 (overall system utilization) "هذا هو "عامل استخدام الخادم :المقياس •

  Rho (ρ) = 0.9333 : النتيجة من الجدول  •

 بخدمة زبون هو :التفسير •
ً
يمكن تفسيرها أيضًا     % 93.33 احتمال أن يكون الموظف مشغولا

 .% من وقته في خدمة الزبائن 93.33بأن الموظف يقض ي 

 متوسط عدد الزبائن المتوقع في صف الانتظار؟  .2

الصف " :المقياس • في  الزبائن  عدد   Average number of customers in the) "متوسط 

queue)ورمزه ، (Lq). 

 Lq = 13.0667 :النتيجة من الجدول  •

ا 13 في أي لحظة زمنية، نتوقع أن نجد حوالي :التفسير •
ً
ينتظرون في الطابور )لا يشمل من   زبون

 .يتلقى الخدمة حاليًا(

 متوسط عدد الزبائن المتوقع في النظام؟  .3
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النظام " :المقياس • في  الزبائن  عدد   Average number of customers in the) "متوسط 

system)ورمزه ، (L). 

 L = 14.0000 :النتيجة من الجدول  •

ا 14 في أي لحظة زمنية، نتوقع أن نجد :التفسير •
ً
في الطابور    13في المصرف بشكل كامل ) زبون

 .يتلقى الخدمة( 1+ 

 متوسط وقت الانتظار للزبون المتوقع في النظام؟  .4

النظام" :المقياس • في  الزبون  يقضيه  الذي  الوقت   Average time a customer) "متوسط 

spends in the system)ورمزه ، (Wb). 

 Wb= 0.1000 hours : النتيجة من الجدول  •

داخل المصرف. لتحويلها إلى دقائق نضرب في  ساعة 0.1  يقض ي الزبون في المتوسط :التفسير •

هذا هو إجمالي الوقت من لحظة دخول المصرف إلى لحظة مغادرته  )  دقائق 6 = 60*   0.1: 60

 (. بعد انتهاء الخدمة

 متوسط وقت الانتظار للزبون في الصف؟  .5

الصف" :المقياس • في  الزبون  يقضيه  الذي  الوقت   Average time a customer) "متوسط 

spends in the queue)ورمزه ، (Wq). 

 Wq = 0.0933 hours :النتيجة من الجدول  •

في الانتظار في الطابور فقط )قبل أن يبدأ  ساعة 0.0933 يقض ي الزبون في المتوسط :التفسير •

دقائق    5حوالي  ( دقائق 5.6 = 60*    0.0933:  60في تلقي الخدمة(. لتحويلها إلى دقائق نضرب في  

 )ثانية 36و 

 الاستنتاج العام للتحليل 

تحليل صفوف الانتظار أعطانا صورة واضحة عن أداء النظام في المصرف. على الرغم من أن معدل  

( )150الخدمة  الوصول  معدل  من  أعلى  جدًا  140(  عالية  إشغال  بنسبة  يعمل  النظام  أن  إلا   ،)

شخصًا(. هذه المعلومات يمكن أن تساعد    13%(، مما يؤدي إلى تكوّن طابور انتظار ملحوظ ) 93.33)

دير المصرف في اتخاذ قرار، مثل التفكير في فتح نافذة خدمة ثانية خلال ساعات الذروة لتقليل وقت  م

 .الانتظار وتحسين رضا العملاء
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 نظرية الألعاب. 7 

 نظرية الألعاب تعريف  . 1.7 

بين   الاستراتيجية  والصراعات  التنافسية  المواقف  لدراسة  يُستخدم  وتحليلي  رياض ي  عمل  إطار  هي 

تقليل   )أو  مكاسبه  تعظيم  بهدف  قراراته  يتخذ  لاعب  كل  "اللاعبون".  عليهم  يُطلق  أكثر  أو  طرفين 

ى القرارات التي خسائره(، مع الأخذ في الاعتبار أن نتائج قراراته لا تعتمد عليه فقط، بل تعتمد أيضًا عل

 .سيتخذها اللاعبون الآخرون 

الإعلانية(،   الحملات  المنتجات،  )تسعير  الاقتصاد  مثل  متنوعة  مجالات  في  الألعاب  نظرية  ستخدم 
ُ
ت

 .السياسة )المفاوضات الدولية، الحملات الانتخابية(، والعلوم العسكرية )الاستراتيجيات الحربية(

 المفاهيم الأساسية . 2.7 

 .أي موقف تنافس ي يتضمن لاعبين، استراتيجيات، ونتائج :(Game) اللعبة •

 .الأطراف المتنافسة التي تتخذ القرارات :(Players) اللاعبون  •

 .مجموعة الإجراءات أو القرارات المتاحة لكل لاعب :(Strategies) الاستراتيجيات  •

جدول يوضح العائد )الربح أو الخسارة( الذي يحصل   :(Payoff Matrix) مصفوفة العائد •

 .عليه كل لاعب نتيجة لتقاطع استراتيجياته مع استراتيجيات اللاعبين الآخرين

الصفري  • المجموع  اللاعبين   :(Zero-Sum Game) لعبة  أحد  ربح  فيها  يكون  التي  الحالة  هي 

 .مساويًا تمامًا لخسارة اللاعب الآخر. ما يكسبه طرف، يخسره الطرف الآخر

 المنافسة الإعلانية بين شركتين: مثال تطبيقي 

، على الحصة السوقية في سوق المشروبات الغازية.  Bوالشركة    Aتتنافس شركتان كبيرتان، الشركة  

 تفكر كل شركة في إطلاق حملة إعلانية جديدة، ولكل منهما ثلاث استراتيجيات ممكنة:

 الإعلان في التلفزيون.  ▪

 الإعلان في الراديو. ▪

 الإعلان في الصحف. ▪

بتقدير الزيادة أو النقصان في حصتها السوقية )كنسبة مئوية( بناءً    Aقام قسم التسويق في الشركة  

على كل تقاطع ممكن بين استراتيجيات الشركتين. هذه التقديرات موضحة في مصفوفة العائد التالية، 

 (. B)وبالتالي خسائر الشركة  Aحيث تمثل الأرقام مكاسب الشركة 
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   Bاستراتيجية الشركة  

 صحف  راديو تلفزيون  A استراتيجيات الشركة

 4 -2 3 تلفزيون 

 2 5 0 راديو

 -1 3 1 صحف 

 

المصفوفة؟ نقرأ  الشركة  كيف  اختارت  إذا  المثال،  سبيل  واختارت   A على  "التلفزيون"  في  الإعلان 

ستربح   B والشركة (السوقية% من حصتها  2ستخسر   A الإعلان في "الراديو"، فإن الشركة B الشركة

2% ) 

 : المطلوب

القراراتباستخدام وحدة   برنامج (Decision Analysis) تحليل  لهذه QSB في  الحل الأمثل  ، أوجد 

 .اللعبة

 :  QSB خطوات الحل باستخدام برنامج  •

 : تشغيل البرنامج واختيار وحدة تحليل القرارات 1الخطوة 

 .QSB افتح برنامج -أ

 تحليل القرارات  Decision Analysis من القائمة الرئيسية التي تظهر لك، ابحث عن وحدة -ب

 .OK أو حددها واضغط Decision Analysis على انقر نقرًا مزدوجًا  -ت

 : تسمية المشكلة وتحديد نوعها 2الخطوة 

، اكتب اسمًا للمشكلة،  عنوان المشكلة Problem Title  ستظهر لك نافذة جديدة. في خانة -أ

 ."مثل "لعبة_الإعلانات

في نفس النافذة، ستجد خيارًا لتحديد نوع المشكلة أو الهدف. ابحث عن قائمة منسدلة أو    -ب

 .مجموعة خيارات
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 لعبة لاعبين ذات مجموع صفري   Two player zero-sum game من هذه الخيارات، اختر -ت

نظرية  في  مسألة  لحل  القرارات  تحليل  وحدة  استخدام  تريد  أنك  البرنامج  يخبر  الخيار  هذا 

 .الألعاب

 :بعد ذلك، سيطلب منك البرنامج تحديد أبعاد المصفوفة  -ث

a. Number of alternatives for player 1  ( 1عدد البدائل للاعب (  

 (.A استراتيجيات الشركة 3( أدخل

b. Number of states of nature for player 2  ( 2عدد حالات الطبيعة للاعب  )

 ( B استراتيجيات الشركة) 3 أدخل

 .OK اضغط -ج

 : إدخال بيانات مصفوفة العائد 3الخطوة 

 .ستظهر لك الآن شاشة إدخال البيانات على شكل مصفوفة -أ

 .قم بإدخال قيم العائد من المثال في هذه المصفوفة -ب

 

 : حل المشكلة وعرض النتائج4الخطوة 
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 Solve and :بعد إدخال البيانات بشكل صحيح، اذهب إلى القائمة العلوية واختر -أ

Analyze → Solve the Problem 

 .سيقوم البرنامج فورًا بحل اللعبة وعرض النتائج في جدول شامل -ب

 

 قراءة وتفسير نتائج تحليل نظرية الألعاب  •

للشركة  الثالثة  الاستراتيجية  أن  البرنامج  في( B يخبرنا  استراتيجية ) الصحف الإعلان  مهيمن  " هي 

 ( التلفزيون  بواسطة استراتيجيتها الأولى )الإعلان في (Dominated) "عليها

هي دائمًا أفضل من أو تساوي   B هذا يعني أن استراتيجية "التلفزيون" بالنسبة للشركة ماذا يعني ذلك؟

 . A استراتيجية "الصحف"، بغض النظر عما تفعله الشركة

تخسر دائمًا   B للتوضيح: إذا قارنا العمود الثالث بالعمود الأول في المصفوفة الأصلية، نجد أن الشركة)

 ( 1>-1، 0<2، 3< 4أكثر أو تربح أقل في حالة "الصحف" مقارنة بحالة "التلفزيون". على سبيل المثال، 

يقوم البرنامج تلقائيًا بحذف هذه الاستراتيجية الضعيفة )الصحف( من حساباته، ويقوم بتبسيط  هنا  

 .، ثم يحل هذه اللعبة المبسطة3x2إلى مصفوفة  3x3 اللعبة من مصفوفة 

 (Optimal Solution) الحل الأمثل •

 .هذا هو الحل للعبة المبسطة، وهو يوضح الاستراتيجيات المثلى وقيمة اللعبة

 Mixed) استراتيجية مختلطةبما أن اللعبة لا تحتوي على نقطة توازن، فإن الحل الأمثل هو 

Strategy). 
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 لتحقيق أفضل عائد ممكن، يجب على الشركة :A (Player 1) الاستراتيجية المثلى للشركة •

A أن تركز بشكل كبير على التلفزيون، مع القليل من التنويع: 

 .التلفزيون  من جهودها للإعلان في%  83 تخصيص •

 .الراديو من جهودها للإعلان في %17 تخصيص •

 .(0%) إعلانات الصحف على الإطلاق  عدم استخدام •

بعد حذف استراتيجية الصحف الضعيفة، يجب   :B (Player 2) الاستراتيجية المثلى للشركة  •

 :أن تقسم جهودها بالتساوي بين الخيارين المتبقيين B على الشركة

 .التلفزيون  من جهودها للإعلان في 50 % تخصيص •

 .الراديو من جهودها للإعلان في  50% تخصيص •

 .(0%) إعلانات الصحف على الإطلاق  عدم استخدام •

 (Value of the Game) قيمة اللعبة •

 .2.50 اللعبة هي قيمة :النتيجة

هذه هي النتيجة المتوقعة للعبة إذا التزم كلا اللاعبين باستراتيجياتهما المثلى. بما أن القيمة  :التفسير

هذا يعني أنه عند اتباع هذه الاستراتيجيات، يمكن  A) الشركة (موجبة، فهي في صالح اللاعب الأول 

في المتوسط. وفي المقابل، يجب    %   2.5 أن تتوقع تحقيق زيادة في حصتها السوقية بمعدل A للشركة

 .(2.5 %) أن تتوقع خسارة نفس النسبة B على الشركة

لتقسيم دفاعها   B للتركيز بشكل كبير على التلفزيون، بينما يوجه الشركة A الحل الأمثل يوجه الشركة

لديها   A ( تظهر أن الشركة2.5القيمة النهائية للعبة ) .A بين التلفزيون والراديو لمواجهة هجوم الشركة

 .موقف تنافس ي أقوى في هذه المعركة الإعلانية
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التحليل الإحصائي للبيانات الفصل الثاني: 

 SPSS باستخدام برنامج
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  SPSS الفصل الثاني: التحليل الإحصائي للبيانات باستخدام برنامج

 تمهيد

لحل  العمليات  بحوث  في  الرياضية  النماذج  استخدام  كيفية  الأول  الفصل  في  استعرضنا  أن  بعد 

، ننتقل الآن إلى جانب آخر لا يقل   WinQSB المشاكل الإدارية واتخاذ القرارات المثلى باستخدام برنامج 

ففي حين تساعدنا بحوث العمليات   .التحليل الإحصائي للبيانات :أهمية في عالم الأعمال واتخاذ القرار

في حل مشاكل التوزيع والجدولة والتخصيص، يساعدنا علم الإحصاء في فهم الواقع نفسه من خلال  

 .البيانات التي نجمعها منه

رياضية  نماذج  في  محددة  الاقتصادية  المؤسسات  تواجه  التي  المشاكل  تكون  لا  الأحيان،  من  كثير  في 

رضا   استبيانات  مثل  متنوعة  مصادر  من  تأتي  وغامضة،  أولية ضخمة  بيانات  من  تبدأ  بل  جاهزة، 

لأمثل؟" العملاء، بيانات المبيعات، أو أبحاث السوق. هنا، يصبح السؤال المحوري ليس "ما هو الحل ا

 ."بل "ماذا تخبرنا هذه البيانات؟

للإجابة على هذا السؤال، نحتاج إلى أداة قوية ومتخصصة في التعامل مع البيانات الإحصائية، وهذا  

برنامج   يلعبه  الذي  الدور  "الحزمة   SPSS (Statistical Package for the Social Sciences)هو  أو 

في   عالميًا  المستخدمة  البرامج  وأقوى  أشهر  أحد  البرنامج  هذا  يعتبر  الاجتماعية".  للعلوم  الإحصائية 

 .تحليل البيانات في مختلف المجالات الأكاديمية والتجارية 

يهدف هذا الفصل إلى تزويد الطالب بالمهارات العملية اللازمة للتعامل مع البيانات من لحظة إدخالها  

 إلى استخراج النتائج والمعلومات القيمة منها. سنبدأ بالأساسيات، حيث نتعرف على  
ً

وتعريفها، وصولا

إ ننتقل  ثم  المختلفة.  المتغيرات  أنواع  مع  التعامل  وكيفية  البرنامج  التحليل الإحصائي، واجهة  قلب  لى 

الإحصائية   الاختبارات  استخدام  وكيفية  البيانات،  لتلخيص  الوصفي  التحليل  إجراء  كيفية  فنتعلم 

 .المعلمية واللامعلمية لاختبار الفروض واتخاذ القرارات بناءً على الأدلة

بعد ذلك، سنتعمق في استكشاف العلاقات بين المتغيرات من خلال تحليل الارتباط والانحدار الخطي  

واللوجستي، وهي أدوات أساسية للتنبؤ وفهم العوامل المؤثرة. وأخيرًا، سنتطرق إلى تقنيات متقدمة مثل  

فها إلى مجموعات ذات  التحليل العاملي والتصنيفي، التي تساعدنا على تبسيط البيانات المعقدة وتصني

 .معنى
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سيمنحك، كطالب في تخصص المالية والتجارة الدولية، القدرة على   SPSS إن إتقان استخدام برنامج 

تحويل البيانات الأولية إلى رؤى استراتيجية، وفهم سلوك الأسواق والعملاء، وتقييم أداء السياسات  

 .المختلفة، وهي مهارات جوهرية لأي محلل أو متخذ قرار ناجح في العصر الحديث
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 والتعامل مع أنواع المتغيرات. SPSSالتعرف على برمجية  .1

 ؟ SPSS ما هو برنامج  .1.1

SPSS     لـ اختصار  الاجتماعية"هو  للعلوم  الإحصائية   Statistical Package for the) "الحزمة 

Social Sciences).   وهو أحد أشهر وأقوى البرامج المستخدمة على مستوى العالم لتحليل البيانات

الإحصائية. على الرغم من أن اسمه يشير إلى العلوم الاجتماعية، إلا أنه يُستخدم على نطاق واسع في  

 .جميع المجالات تقريبًا، بما في ذلك إدارة الأعمال، المالية، التسويق، الطب، والهندسة

 ؟SPSS لماذا نستخدم .  2.1

الاستخدام • مما   :سهولة  والنوافذ،  القوائم  على  تعتمد  التعامل  سهلة  رسومية  واجهة  يوفر 

 .يجعله أسهل بكثير من كتابة الأكواد البرمجية للتحليل الإحصائي

يحتوي على مكتبة ضخمة من الاختبارات والتحليلات الإحصائية، بدءًا من   :القوة والشمولية •

 إلى النماذج المتقدمة المعقدة
ً

 .الإحصاء الوصفي البسيط ووصولا

البيانات • وهو جزء   :إدارة  تعديلها، وتحويلها،  تنظيفها،  البيانات،  قوية لإدخال  أدوات  يوفر 

 .أساس ي من أي عملية تحليل

يقدم النتائج في جداول ورسوم بيانية واضحة ومنظمة، جاهزة للتفسير   :المخرجات الواضحة •

 .والإدراج في التقارير والأبحاث

 تشغيل البرنامج.  3.1

أو بالنقر المزدوج على أي ملف   (Start) ابدأ، يمكن تشغيله من خلال قائمة  SPSSبعد تثبيت برنامج  

 .sav.الامتداد  بيانات يحمل

 :عند فتح البرنامج، تظهر واجهة البداية التي تتيح للمستخدم

 .فتح ملف موجود مسبقًا •

 .إنشاء ملف بيانات جديد •

 أو قواعد بيانات أخرى  Excel استيراد بيانات من  •
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افذ الأساسية في  . 4.1   SPSSالنو

 الشاشتان الأساسيتان  :SPSS الواجهة الرئيسية لبرنامج . 1.4.1

، ستلاحظ أنه يتكون بشكل أساس ي من شاشتين رئيسيتين يمكنك التنقل بينهما  SPSS عند فتح برنامج

التعامل مع   في أسفل يسار الشاشة. فهم وظيفة كل شاشة هو مفتاح  باستخدام الألسنة الموجودة 

 .البرنامج

 

 :(Data View) أ. شاشة عرض البيانات

ستخدم .Excel هذه الشاشة تشبه إلى حد كبير ورقة عمل في برنامج :الوظيفة •
ُ
لإدخال  ت

 .للاستبيان أو الدراسة البيانات الفعلية
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 :الهيكل •

كل صف يمثل حالة واحدة )مثل:   .(Cases) الحالات تمثل :(Rows) الصفوف  •

 .شخص واحد، شركة واحدة، استبيان واحد(

كل عمود يمثل متغيرًا واحدًا   .(Variables) المتغيرات  تمثل  :(Columns) الأعمدة  •

 .تم قياسه )مثل: العمر، الجنس، الدخل، إجابة سؤال معين(

 .التي قمت بجمعها البيانات الخام في هذه الشاشة، أنت ترى  :باختصار •

 

 :(Variable View) ب. شاشة عرض المتغيرات

ستخدم :الوظيفة •
ُ
لتعريف  هذه الشاشة هي "بطاقة الهوية" أو "دفتر التعريفات" لمتغيراتك. ت

قبل إدخال البيانات. إعداد هذه الشاشة بشكل صحيح هو أهم خطوة  وتوصيف كل متغير

 .لضمان دقة التحليل

 :الهيكل •

 .متغيرًا واحدًا كل صف يمثل :(Rows) الصفوف  •

 .هذا المتغير خاصية من خصائص كل عمود يمثل :(Columns) الأعمدة  •
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 (Variable View) تعريف المتغيرات: أهم خصائص شاشةت. 

 :وكيفية إعدادها Variable Viewلنتعرف على أهم الأعمدة في شاشة 

1. Name   (الاسم)  :هو الاسم البرمجي للمتغير )مثل ( Age, Q1, Gender).    ،يجب أن يبدأ بحرف

استخدام )يمكن  خاصة  رموز  أو  مسافات  على  يحتوي  من    _ لا  المتكون  الاسم  بين  للربط 

 كلمتين( 

2. ) Type وهما نوعان: يحدد نوع البيانات في المتغير (:النوع 

A. ) Numeric نعطيها ) :رقمي التي  الوصفية  للمتغيرات  حتى  استخدامًا،  الأكثر  النوع  هو 

 .=أنثى(2=ذكر،  1أكوادًا رقمية )مثل: 

B. String  (يُستخدم لإدخال نصوص مفتوحة )مثل: الأسماء، الملاحظات() : نص ي.  

3.  Label (التوصيف)  :  النتائج في جداول  الذي سيظهر  للمتغير  المطول  التوضيحي  هو الاسم 

الخدمة"( عن  الرضا  "مستوى  المشارك"،  "عمر  )مثل:  البيانية  الم   .والرسوم  جدًاومن   هم 

استخدم توصيفًا واضحًا هنا، لأنه يجعل مخرجاتك مفهومة. يمكن أن يحتوي على مسافات  

 .ورموز 

4. ) Values ستخدم  :(القيم
ُ
ت والترتيبية(.  )الاسمية  الفئوية  للمتغيرات  الخاصية   لترميز هذه 

(Coding) الفئات النصية إلى أرقام. 

 :لمتغير "الجنس"، نضغط على هذا الحقل ونقوم بالتعريف كالتالي : مثال
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1.  Value: 1 -> Label:  ذكر 

2.  Value: 2 -> Label: أنثى 

 .يعني "ذكر" عند عرض النتائج 1 هذا يسمح للبرنامج بفهم أن الرقم

5. ) Measure لاختيار    :(المقياس الأهمية  بالغ  أمر  وهو  للمتغير،  القياس ي  المستوى  يحدد 

 وهناك ثلاث مقاييس وهي:   التحليل الإحصائي المناسب

A. Scale   (مقياس كمي  :)   للمتغيرات الرقمية المستمرة التي يمكن إجراء عمليات حسابية عليها

 .)مثل: العمر، الدخل، درجة الحرارة(

B. Ordinal   (مقياس ترتيبي:)   ،"للمتغيرات الفئوية التي يوجد لترتيبها معنى )مثل: "موافق بشدة

 ."موافق"، "محايد" أو "مستوى التعليم"(

C. Nominal (  للمتغيرات الفئوية التي لا يوجد لترتيبها أي معنى )مثل: الجنس،  ): اسميمقياس

 .الجنسية، فصيلة الدم(

 :     Window viewer النتائج  ومعالجة عرض  إطار . 2.4.1

  تنقسم التي  Output SPSS viewer العرض  شاشة على  الإحصائية  العمليات نتائج  SPSS برنامج  يظهر

 القسم أما تنفيذه، تم الذي  الاجراء بنوع خاصة معلومات على يحتوي  الأيسر القسم قسمين، الى

 اختبارات نتائج أو بيانية رسومات  أو إحصائية جداول  كانت  سواء نفسها النتائج على  فيحتوي  الأيمن

 .معينة
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  SPSS باستخدام الحاسب إلى وإدخالها البيانات تجهيز .5.1

عدّ 
ُ
 تعتمد إذ إحصائية، دراسة أي في المراحل أهم من  الحاسب  إلى وإدخالها البيانات تجهيز مرحلة ت

 يوفر SPSS برنامج  .المعالجة قبل وتنظيمها البيانات إعداد دقة مدى  على نتائجه وصدق التحليل جودة

 من استيرادها أو يدويًا  إدخالها تم سواء علمية، بطرق  وتحليلها وترميزها البيانات لتخزين متكاملة بيئة

 .البيانات قواعد أو Excel مثل أخرى  تطبيقات

 (Data Coding) البيانات ترميز. 1.5.1

 رقمية قيم إلى  ( ...القطاع التعليمي، المستوى  كالنوع،)   النوعية المعلومات تحويل عملية هو الترميز

 .البرنامج في وتحليلها  إدخالها ليسهل
 الرمز الفئة  المتغير

 1 ذكر  الجنس

 2 انثى 

 1 ابتدائي المستوى التعليمي

 2 ثانوي 

 3 جامعي 

 :SPSS في الترميز خطوات  -أ

 .Variable View نافذة إلى الانتقال

 .مسافات بدون  (Name) المتغير اسم  إدخال

 .String أو Numeric المتغير نوع تحديد

 .معناها وتحديد القيم رموز  لإدخال Values الخانة على الضغط

 Nominal، Ordinal، Scale المتغير مقياس تحديد

 والشكل الموالي يوضح ذلك: 
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 (Manual Data Entry) يدويًا البيانات  إدخال. 2.5.1

 صف وكل متغيرًا، يمثل عمود  كل .القيم لإدخال Data View نافذة إلى ننتقل الترميز، من  الانتهاء بعد

 قيمة  أي  تعديل  يمكن .مسبقًا ترميزها تم التي الرقمية القيم إدخال يتم .ملاحظة أو حالة يمثل

 .مباشرة وتغييرها الخلية على بالنقر

 كما يجب أن:

 .المحددة الرموز  وفق القيم إدخال من نتأكد -

 .الحالات لترتيب  Data → Sort Cases استخدام -

 .المفقودة القيم لاكتشاف  Data → Validate Data استعمال  يمكن -

 

 : SPSS الى أخرى  تطبيقات من استدعاء. 3.5.1

 :طريقتين عبر وذلك SPSS برنامج الى ( Excel )مثل أخرى  تطبيقات من بيانات  استدعاء يمكن
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 ؛  SPSS صفحة ف ولصقها المصدر الملف من البيانات نسخ •

 فتظهر Data الفرعي الامر على ننقر ثم ، File القائمة  من  Open الامر نختار SPSS صفحة  من •

 :التالية النافذة لنا

 

 
 في يكتب للملف اسما  نختار  ثم ، Files of type المستطيل من Excel الملف  نوع فيه نحدد والذي 

  Open  على ننقر  النهاية يوف ، File name المستطيل

 SPSS (Saving Files) في الملفات حفظ. 6.1

 ة: لحفظ الملفات في البرنامج نتبع الخطوات التالي

 كما في الشكل الموالي:File → Save As القائمة من •

 المستطيل من )"desktop" هنا اخترنا( فيه الملف حفظ في نرغب الذي  الدليل بتحديد نقوم •

Look in  ؛ 

 ؛  File name المستطيلفي   )"1استبيان " هنا اخترنا( للملف اسم نختار •

 ؛  Save as type المستطيل من  حفظه ف نرغب الذي  الملف  نوع اختيار يمكننا  كما •
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 ؛  Save زر  على ننقر •

 استخدام يمكننا كذلك الأولى، المرة بعد البيانات لحفظ File القائمة من  Save الامر نختار •

 .ذاته للغرض  الايقونة

 التحليل الاحصائي للبيانات  .2

  نتناول في هذا الصدد الأوامر الخاصة بالتحليل الوصفي للبيانات الاحصائية التي يتوفر عليها

وهي القائمة الخاصة بمختلف العمليات الاحصائية،  Analyze من خلال القائمة SPSS البرنامج 

الذي يحتوي بدوره على مجموعة من الأوامر التي تقوم  Descriptive Statistics نجد الأمر بحيث

 إحصاءات لإنتاج يُستخدم الذي  Frequencies اضافة الى الأمر التحليل الوصفي للبيانات تبإجراءا 

 .Exploreوكذلك الامر  للمتغيرات تكرارية وجداول  وصفية

 : Frequencies لأمرا. 1.2

وجه    يستخدم هذا الأمر عموما في التحليل الوصفي لمختلف البيانات الاحصائية، لكنه يستخدم على

وصف    الخصوص للمتغيرات الإسمية او الترتيبية التي تتكون من مجموعة محدودة من الفئات، لغرض 

بذلك، الخاصة  البيانية  المخططات  وبعض  التكرارية  الجداول  خلال  من  متغيرات  عدة  أو    متغير 

بالإضافة إلى حساب مجموعة من المؤشرات الاحصائية الوصفية وهي تتمثل في مقاييس النزعة المركزية  

 ) الوسط الحسابي، الوسيط، المنوال...( ومقاييس التشتت ) الانحراف المعياري، التباين،....(، إلى جانب 

  لمرتبطة بالرتب كالمئيناتمقاييس لتحديد شكل التوزيع )معامل التفرطح والالتواء( وبعض المؤشرات ا 

  والربيعيات. بالرغم من أن هذه المؤشرات لا يمكن استعمالها في حالة المتغيرات النوعية ذات الطابع 

 .الاسمي، لكن تم تزويد هذا الأمر بها لاستعماله في حالات المتغيرات الترتيبية والكمية على حد سواء



 د/ باهي وف اء       SPSS التحليل الإحصائي للبيانات باستخدام برنامج الفصل الثاني:  

57 

 

الأمر استعمال  يمكن  المرتبطة Frequencies كما  البيانية  الرسومات  بعض  بالتحليل    كذلك لإعداد 

أو  الاسمي  الطابع  ذات  النوعية  للمتغيرات  بالنسبة  النسبية  والدوائر  التكرارية  كالأعمدة    الوصفي 

 .الترتيبي، والمدرج التكراري الذي يستخدم فقط في حالة المتغيرات الكمية

 Frequencies الأمر  تنفيذ  خطوات .1.1.2

 .Analyze → Descriptive Statistics → Frequencies اختر القوائم شريط من .1

 .Frequencies الأمر نافذة ستظهر .2

 .Variable(s) المربع إلى وانقلها تحليلها في ترغب التي المتغيرات حدد .3

،  Mean ،Median ،Modeلاختيار الإحصاءات التي ترغب في حسابها مثل:  Statisticsاضغط على زر 

Std. deviation ثم نضغط على .contunue  ثم نضغط علىOK 
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 الجداول ح في موض  هو كما ، Output Viewer النتائج مستعرض شاشة ف النتائج تظهر  سوف

 :الموالية
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للمتغيرات  Pie chart و Bar chart لتمثيل النتائج السابقة بيانيا، غالبا ما نستخدم الرسوم البيانية

 للمتغيرات الكمية. على سبيل المثال ولإنشاء رسم بياني من نوع   Histograms نستخدم  النوعية، بينما

Bar chart  فوق على Analyze القائمة  ننقر  ننقر  ثم   ، Descriptive Statistics ثم Frequencies   ،

 التي نرغب ف انشاء رسوم بيانية لها وننقر على السهم لتحويلها الى مربع  )ونختار المتغير (أو المتغيرات

Variable(s)  ثم ننقر فوق ، Charts 

 :ليظهر مربع الحوار المبين ف الشكل التالي

 
 ، مع إمكانية الاختيار بين التكرار او النسب المئوية من مربع chart Type من مربع Bar charts نختار

chart Values .  ثم ننقر فوق Continue  ثم ننقر فوق ، OK فنتحصل الى الرسم البياني التالي ،: 
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نوع من  بياني  رسم  القائمة Pie charts ولإنشاء  فوق  على Analyze ننقر  ننقر  ثم   ، Descriptive 

Statistics  ثم Frequencies   ونختار المتغير )و المتغيرات(التي نرغب في انشاء رسوم بيانية لها وننقر ،

ليظهر مربع الحوار المبين في الشكل   Charts ثم ننقر فوق  Variable(s) مربع  على السهم لتحويلها الى

 :التالي

 
 ، مع إمكانية الاختيار بين التكرار او النسب المئوية من مربع chart Type من مربع Pie charts نختار

chart Values .  ثم ننقر فوق Continue  ثم ننقر فوق ، OK فنتحصل الى الرسم البياني التالي ،: 
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 Descriptives الأمر. 2.2 

الأمر مختلف  Descriptives يفيدنا  بحساب  المتغيرات  من  غيرها  دون  الكمية  البيانات  تحليل    في 

المؤشرات الاحصائية الوصفية من مقاييس النزعة المركزية، التشتت والتوزيع حسب حاجة الباحث،  

يسمح باستخراج مختلف المؤشرات لمتغير واحد أو عدة متغيرات في جدول واحد مع امكانية    بحيث

  . Descriptives اختيار المؤشرات من خلال صندوق الحوار المستخدم

نتبع   مختارة  كمية  لمتغيرات  التشتت،  مقاييس  وبعض  المركزية  النزعة  مقاييس  بعض  ولاستخراج 

 :الخطوات التالية

، كما   Descriptives ثم Descriptive Statistics ، ثم ننقر على Analyze ننقر فوق القائمة ▪

انشاء متغير جديد يحتوي على العلامات المعيارية المقابلة لكل مفردة من العينة،    يمكن اختيار

 :فنتحصل على الشكل التالي Save standardized values as variables وذلك بالنقر على
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او  )ات المراد استكشاف بياناتها بالنقر عليها مرة واحدة ثم النقر على السهم ر نختار المتغي ▪

ليظهر مربع الحوار   Options ، ثم ننقر فوق  Variable(s) مربع  ، فتتحول الى(بالنقر المزدوج 

 :الشكل التالي يالمبين ف

 

 
 continueنختار بعض الاحصاءات الوصفية كما هي مبينة في الشكل أعلاه ثم نضغط على   ▪

 . okللعودة الى مربع الحوار الأول ثم نضغط على 

، كما هو موضر ف الجداول   Output Viewer سوف تظهر النتائج ف شاشة مستعرض النتائج

 :الموالية
Descriptive Statistics 

 N Minimum Maximum Mean Std. Deviation 

Y 16 3.16 11.48 7.6425 2.04304 

X1 16 2.26 4.24 3.1238 .56106 

X2 16 2.85 4.04 3.4306 .32238 

Valid N (listwise) 16     

 

 : Explore  الأمر . 3.2

في استكشاف البيانات، بحيث يسمح بتقديم ملخص احصائي للبيانات واعداد  Explore   يفيد الأمر

  مخططات لكل الحالات أو لمجاميع معينة، كما يسمح بإعطاء صورة للبيانات لمعرفة مدى صلاحيتها

 لإجراء تحليل احصائي معين,
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 :حساب الإحصاءات الوصفية لمتغير كمي 1.3.2

 :لاستخراج الإحصاءات الوصفية لمتغير كمي نتبع الخطوات التالية

، فنتحصل على   Explore ثم Descriptive Statistics ، ثم ننقر على Analyze ننقر فوق القائمة -أ

 :الحوار التالية شاشة

 
على   .1 النقر  ثم  واحدة  مرة  عليه  بالنقر  له،  الوصفية  الإحصاءات  المراد حساب  المتغير  نختار 

المزدوج بالنقر  )او  مربع   ، )السهم  الى  مربع . Dependent List فيتحول  يمكننا   Display من 

 Statistics دون الرسوم البيانية عبر النقر فوق   الاختيار بين عرض الإحصاءات الوصفية فقط 

، أو عرض   Plots فوق   ، أو عرض الرسوم البيانية فقط دو ن الإحصاءات الوصفية عبر النقر 

 وهو ما سنختاره ف مثالنا. ثم Both الإحصاءات الوصفية والرسوم البيانية معا عبر النقر فوق 

 :ليظهر مربع الحوار المبين ف الشكل التالي Statistics ننقر فوق 

 
 Continue على  ننقر  ذلك   بعد . Percentiles و  ، Outliers و   ،  M-estimators و   ، Descriptives نختار 

، 



 د/ باهي وف اء       SPSS التحليل الإحصائي للبيانات باستخدام برنامج الفصل الثاني:  

64 

 

ح  موض  هو  كما  ، Output Viewer النتائج  مستعرض  شاشة  ف  النتائج  تظهر  سوف  ، OK فوق   ننقر  ثم

 : الموالية الجداول في 

 
الجدول  المقطوع  يبين  والمتوسط  والوسيط  الحسابي  المتوسط  مثل  الوصفية  الإحصاءات   نتائج 

(Trimmed Mean)،   من البيانات وذلك لإلغاء  5% واقل  5المتوسط الحسابي بعد حذف أعلى    وهو %

مقاييس التشتت التي تحتوي على الخطأ المعياري والانحراف    أثر القيم الشاذة ان وجدت. بالإضافة الى

يظهر الإحصاءات الخاصة بشكل التوزيع    المعياري والتباين واقل قيمة واعلى قيمة والمدى الربيعي، كما

  .Kurtosis والتفرطح Skewness كالالتواء

 
 .)تقديرات للمتوسطات التي لا تتأثر بالقيم الشاذة )كما ف المتوسط المقطوع يوضح الجدول 

 
 

هو القيمة   20المئينيات، وهي القيم التي يقل عنها نسبة معينة من البيانات، مثلا المئين      يوضح الجدول 

 .من البيانات % 20التي يقل عنها 
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يوضح الجدول ما إذا كانت هناك قيم شاذة. واستخراج أكبر خمسة قيم واقل خمسة قيم شاذة،  

 .البيانات حتى لا تؤثر ف الاختبارات الإحصائية الأخرى  وذلك تمهيدا لحذفها من

 :حساب الإحصاءات الوصفية لمتغير كمي حسب فئات متغير نوعي. 2.3.2

"  Age_Groupبالاعتماد على نفس المثال السابق، لاستخراج الإحصاءات الوصفية للمتغير الكمي " 

 :" نتبع الخطوات التاليةGenderحسب فئات المتغيرالنوعي " 

، فنتحصل على   Explore ثم Descriptive Statistics ، ثم ننقر على Analyze ننقر فوق القائمة -أ

 :الحوار التالية شاشة

 

يمكننا الاختيار بين عرض الإحصاءات الوصفية فقط دون الرسوم البيانية عبر   Displayمن مربع  -ب

النقر فوق  Statistics النقر فوق  عبر  الوصفية  الإحصاءات  دو ن  البيانية فقط  الرسوم  أوعرض   ، 
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Plots البيانية معا عبر النقر فوق  ، أو عرض الإحصاءات الوصفية والرسوم Both يوهو ما سنختاره ف 

 :الشكل التالي ليظهر مربع الحوار المبين في Statistics مثالنا. ثم ننقر فوق 

 

 

 بعد ذلك ننقر على . Percentiles ، و Outliers ، و M-estimators ، و Descriptives نختار  -ج

Continue ،  ثم ننقر فوق OK سوف تظهر النتائج ف شاشة مستعرض النتائج ، Output Viewer   ،

 :الجداول المواليةي كما هو موضح ف

 

 

ف لكل  الوصفية  الإحصاءات  نتائج  الجدول  فئيبين  من  المتغيئاة  أنثى،  رت  وهي:  مثل    ذكر،  النوعي  

المقطوع والمتوسط  والوسيط  الحسابي  بعد  ( Trimmed Mean) المتوسط  الحسابي  المتوسط  ، وهو 
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% من البيانات وذلك لإلغاء أثر القيم الشاذة ان وجدت. بالإضافة الى مقاييس  5واقل   %5حذف أعلى  

المعياري والانحراف المعياري والتباين واقل قيمة واعلى قيمة والمدى    التشتت التي تحتوي على الخطأ

 .Kurtosis حطر والتف Skewness كالالتواء الربيعي، كما يظهر الإحصاءات الخاصة بشكل التوزيع 

 

 
 

يوضح الجدول تقديرات للمتوسطات التي لا تتأثر بالقيم الشاذة كما ف المتوسط المقطوع، لكل فئة 

 من فئات المتغير 

 ) أنثى، ذكر(  " وهي:Genderالنوعي "

 
" وهي: أنثى دكر وهي القيم التي Genderيوضح الجدول المئينيات لكل فئة من فئات المتغير النوعي "

 .% من البيانات20هو القيمة التي يقل عنها   20يقل عنها نسبة معينة من البيانات، مثلا المئين 
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" وهي:  Genderيوضح الجدول ما إذا كانت هناك قيم شاذة لكل فئة من فئات المتغير النوعي " 

أنثى،ذكر واستخراج أكبر خمسة قيم واقل خمسة قيم شاذة، وذلك تمهيدا لحذفها من البيانات حتى 

 .لا تؤثر في الاختبارات الإحصائية الأخرى 

 SPSSالفروض والاختبارات الإحصائية المعلمية واللامعلمية في برنامج .3

 (Parametric Tests):الاختبارات المعلمية. 1.3

 اختبار التوزيع الطبيعي  أولا: 

التوزيعس ي تتبع  كونها  بيانات ظاهرة معينة ف  توزيع  الطبيعي  من    تخدم هذا الاختبار لمعرفة طبيعة 

الفرضيات لأن  اختبار  في  يكون    عدمه. وهذا الاختبار ضروري  أن  تشترط  المعلمية  معظم الاختبارات 

 عي.توزيع البيانات طبي

 يا هناك طريقتا ن رئيسيتا ن لاختبار التوزي ع الطبيعي: بيانيًا وعدد

 :ولإجراء اختبار التوزيع الطبيعي بيانيا، نتبع الخطوات التالية ▪

،   Explore ثم Descriptive Statistics ، ثم ننقر على Analyze ننقر فوق القائمة -أ

 :فنتحصل على الشاشة
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"، بالنقر عليه مرة واحدة ثم  Yالكمي المراد اختبار التوزيع الطبيعي له "  رنختار المتغي -ب

نختار عرض   Display. من مربع    Dependent Listالنقر على السهم، فيتحول الى مربع  

 Plots. ثم ننقر فوق    Bothالإحصاءات الوصفية والرسوم البيانية معا عبر النقر فوق  

 ليظهر مربع الحوار المبين ف الشكل التالي:

 
  Factor نختار Boxplots ، ومن مربع Histogram نختار  Descriptive من مربع  -ت

levels together    وننقر فوق Continue   ثم ننقر فوق OK  
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  شكال، كما هو موضح في الأ  Output Viewer النتائج سوف تظهر النتائج ف شاشة مستعرض 

 :الموالية

 

يتضح من الرسومات أعلاه أن الرسم البياني لبيانات العينة منحنى طبيعي حيث أن البيانات موزعة  

وبذلك    ومتناظرة الى حد ما كما أن التبعثر قريبا جدا من الخطف  بشكل جرس ي مع وجود ذروة في المنتص

 " يتبع التوزيع الطبيعيYيمكننا القول بأن المتغير "

باستخدام   ▪ وذلك  العددية  الطريقة  فهي  الطبيعي  التوزيع  اختبار  الثانية لاجراء  الطريقة  أما 

 Shapiro-Wilkواختبار  Kolmogorov-Smirnovاختبار 
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سمرنوف لمعرفة توزيع البيانات إذا كان حجم العينة أكبر  –مع ملاحظة أنه يستخدم اختبار كولمجروف   

( إذا كان حجم العينة أقل من    (Shpiro-Wilk  ويلك  -بينما يستخدم اختبار شبيرو  50من أو يساوي  

50. 

بيانيا.   الطبيعي  التوزيع  اختبار  الخطوات لإجراء  نفس  نتبع   ، الطبيعي عددي  التوزيع  اختبار  ولإجراء 

 ، كما هو موضح ف الجدول الموالي: Output Viewer شاشة مستعرض النتائجي سوف تظهر النتائج ف

 
وبالرجوع الى قيمة والتي  Shapiro-Wilk فإن الاختبار الأنسب هو اختبار  16بما ان حجم العينة يساوي  

المفترض    0.791 تساوي  المعنوية  أكبر من مستوى  البديلة    0.05وهي  الفرضية  ، وعليه فإننا نرفض 

 " تتبع التوزيع الطبيعي.Yونقبل الفرضية الصفرية، أي أن بيانات المتغير "

 

 :  One Sample T-Testختبار ستيودنت للعينة الواحدةا ثانيا: 

الكشف عن   في  الاختبار  واحد، ويستخدم هذا  قياس  واحدة، عن طريق  لعينة  الفروق  هو لحساب 

وجود اختلاف معنوي، للوسط الحسابي لمتغير ما لعينة واحدة عن قيمة محددة ثابتة. ولهذا الاختبار  

 :عدة شروط وهي كالتالي

 يجب اختيار العينة بطريقة عشوائية  .1

 يجب أن يتبع المتغير التابع التوزيع الاعتدالي .2

 .يجب ان تتسم المشاهدات بالاستقلالية .3

 .يجب أن يكون المتغير التابع مقاسا على أساس المستوي الكمي .4

( كم، من  10000فمثلا ادعت احدى الشركات تصنيع السيارات بأنها تضمن سلامة سياراتها لمسافة )

سيارات فوجد  10أي عطل وأنها تتحمل الأعطال كافة التي قد تحصل فسحبت عينة عشوائية بحجم 

 بانها قد تعرضت للأعطال بعد قطعها للمسافات المبينة أدناه: 

8500 11000 10000 12200 9500 

8750 12000 9800 10000 8800 

 

 المطلوب : 

 كم   10000اختبار إدعاء الشركة بأن متوسط المسافة المقطوعة قبل اول عطل هو 
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 خطوات الحل: 

o :كتابة فرضية الاختبار وهي 

: u = 100000H 

: u ≠ 100001H 

 

 

o :وللقيام بهذا الاختبار في البرنامج نتبع الخطوات التالية 

 

Analyze → Compare Means → One-Sample T-Test 

 فيظهر لنا مربع الحوار كما يلي:

 
o "نقوم باختيار المتغير المراد مقارنة متوسطه وهوdistance   بالضغط عليه مرتين أو "

ثم نقوم بكتابة القيمة   Test variable(s)  تحديده والضغط على السهم لنقله الى مربع  

"  test valueالمراد اختبار الفروق في ضوئها تحت مسمى   " ثم  10000وفي حالتنا هي 

 فتظهر لنا النتائج التالية:  OKنضغط على 
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بلغ   التي تم أخذها  العينة  لنا أن متوسط أجر  والانحراف    10وعددها    10055ومن المخرجات يظهر 

"  10000والقيمة المراد اختبار الفروق في ضوئها "  413.01399وخطأ معياري    1306.06491المعياري  

بلغ    0.133بلغت    tوقيمة   الإحصائية  الدلالة  من    0.897ومستوى  أكبر  المعنوية    0.05وهي  مستوى 

هناك فرق ذو    ه ليسالمفترض، وبالتالي فإننا نرفض الفرضية البديلة ونقبل الفرضية الصفرية، أي ان

 دلالة إحصائية بين متوسط العينة والقيمة المفترضة أي أن ادعاء الشركة صحيح. 

  Paired Samples T-Test ثالثا: اختبار ستيودنت للعينات المزدوجة

تعتبر العينات المزدوجة عبارة عن عينتين من نفس الافراد، بمعني أن الافراد ليسوا مستقلين، 

ويستخدم هذا الاختبار لعمل مقارنة بين متوسطي عينتين مرتبطتين ودراسة الفروق بينهما عن طريق  

 :وهي كالاتي النوع شروطاستخدام اختبار قبلي واختبار بعدي، وعمل اختبارين مختلفين ولهذا 

 أن يكون توزيع الفرق بين المتغيرين أو العينتين طبيعيا  .1

 أن تكون قيمة الفرق بين المتغيرين او العينتين مستقلة بعضها عن البعض  .2

 )يحسب قيمة الفرق بين المتغيرين بطرح قيمة احد المتغيرين من الآخر( 

 مثال: 

طلاب لتحديد مهاراتهم في استخدام الحاسوب قبل دورة التقوية وبعدها فكانت درجاتهم   10اختبر 

 كما يأتي: 

 50 43 53 45 63 50 40 60 55 65 قبل الدورة 

 55 60 80 65 90 63 50 70 75 88 بعد الدورة 

 المطلوب: 

 اختبار الفرض القائل بأنه لاتوجد فروق ذات دلالة إحصائية بين درجات الطلاب قبل الدورة وبعدها 

 خطوات الحل: 
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 كتابة الفرضية:  .1

2= u 1: u0H 

2≠ u 1:  u1H 

 حيث أن:

1u  متوسط الدرجات قبل الدورة 

2U  متوسط الدرجات بعد الدورة 

 ادخال البيانات وتسمية المتغيرات قبل وبعد  .2

 وللقيام بهذا الاختبار في البرنامج نتبع الخطوات التالية:

Analyze → Compare Means → paired Sample T-Test 

 فيظهر لنا مربع الحوار كما يلي:

 
ثم قم بنقل هذين المتغيرين الى المربع الذي   اضغط  مرة واحدة على المتغير قبل ثم على المتغير بعد

 وذلك من خلال الضغط على السهم الصغير الموجود بين المربعين Test Pair(s) Listبعنوان 
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 فتظهر النتائج كما يلي: OKثم نضغط 

 

والخطأ   المعياري  والانحراف  الحسابي  الوسط  من  كل  حساب  تضمن  قد  الاول  الجدول  أن  نلاحظ 

اما    0.864المعياري لكل عينة والجدول الثاني قد تضمن حساب قيمة معامل الارتباط لبيرسون وقيمته  

وهي أقل    0.000ومستوى الدلالة الإحصائية لها والتي بلغت    tالجدول الثالث فقد تضمن حساب قيمة  

مما يدل على رفض فرضية العدم أي أن هناك فروق ذات دلالة إحصائية    0.05من مستوى المعنوية  

 بين درجات الطلاب قبل الدورة وبعدها. 

 :للعينات المستقلة T رابعا: اختبار

يستخدم هذا الاختبار لقياس الفرق المعنوي بين متوسطي عينتين مستقلتين حيث يضم هذا الاختبار  

التجميع   متغير  هما:  المتغيرات  من  ومتغير    Grouping variableنوعين  المستقلتين  العينتين  ويضم 

ويضم متغير الدراسة مثل "اختبار الفرق لمتوسط المستوى الثقافي بين الرجال    Test variableالاختبار  

 والنساء"، " اختبار الفرق بين مستوى طلاب قسم التسيير وقسم التجارة" . 

 ويفترض في هذا الاختبار أن يكون توزيع متغير الاختبار طبيعيا لكل عينة من عينات متغير التجميع. 

 يستخدم هذا الاحتبار لحالتين هما: 

 افتراض أن تباين العينتين متساو.  .1

 افتراض ان تباين العينتين غير متساو  .2
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 تطبيقي:   مثال

 اجري اختبار في مادة الحاسوب لعينتين من الطلاب و الطالبات فكانت درجاتهم كما يأتي:

 95 65 100 85 100 93 80 68 75 93 85 100 الطلاب 

 88 63 90 100 75 88 85 95 53 75 55 70 الطالبات

 المطلوب: 

 هل هنالك اختلاف بين مستوى الطلاب والطالبات 

 خطوات الحل: 

 كتابة فرضية الاختبار وهي: .1

2= u 1: u0H 

2≠ u 1:  u1H 

 حيث أن:

1U  متوسط درجات الطلاب 

2U متوسط درجات الطالبات 

(  1والذي مثل فيه الطلاب بالرقم ) Group  ادخال البيانات وتسمية المتغير الأول ب  .2

الذي يشمل درجات مادة   Computer( وتسمية المتغير الثاني ب 2والطالبات بالرقم )

 الحاسوب لكل من الطلاب والطالبات 

 وللقيام بهذا الاختبار في البرنامج نتبع الخطوات التالية:

Analyze → Compare Means → Independent sample T-Test 

 فيظهر لنا مربع الحوار كما يلي:

 
 فيظهر لنا مربع الحوار التالي: define groupثم نضغط على 
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كما هو موضح في الشكل أعلاه ثم نضغط    group2بجانب  2والرقم  group1بجانب  1حيث نكتب 

فتظهر النتائج كما في الجدول   okفيتم الرجوع الى الشكل السابق ثم نضغط على  continueعلى 

 التالي:

 

تساوي    sigلتجانس التباين وقد كانت قيمة    leveneنلاحظ ان الجدول الثاني قد تضمن نتائج اختبار  

مما يدل على تجانس التباين بين العينتين أي عدم وجود    0.05وهي أكبر من مستوى المعنوية    0.355

 فروق معنوية بين تباين العينتين. 

نتائج اختبار   العينتين لدا   tونلاحظ ان الجدول قد تضمن  بين  التباين  لحالتي تساوي وعدم تساوي 

فاذا كانت النتيجة تجانس التباين فنعتمد    leveneتعتمد النتيجة المناسبة بالاعتماد على نتيحة اختبار  

واذا كانت النتيجة عدم تجانس التباين فنعتمد النتائج    Equal Varances Assumedالنتائج المقابلة ل 

ل قيمة    Equal Varances Not Assumed المقالة  أن  نلاحظ  مثالنا  من    0.151هي     sigوفي  اكبر  هي 

المعنوية   الطلاب    0.05مستوى  مستوى  بين  إحصائية  دلالة  ذات  فروق  لاتوجد  انه  على  يدل  مما 

 والطالبات في مادة الحاسوب.
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 Non – Parametric Testsالاختبارات اللامعلمية:  .2.3

خصائص المجتمع أو ما يسمى   ان الاختبارات التي تناولناها سابقا هي اختبارات معلمية لأنها تتعامل مع

توافر شروط معينة مثل أن يكون توزيع    معالمه، وهذه الاختبارات المعلمية لا يمكن تطبيقها إلا في حالة

المجتمع طبيعيًا أو أن يكون حجم العينة كبير أو أن تكون هناك شروطا خاصة فيه للتباين وغيرها من  

 .الشروط

  وعند عدم توفر شروط الاختبارات المعلمية فإننا لا نستطيع تطبيقها، وبالتالي فإننا سنحتاج لبديل 

الحساب ولا    وهذا البديل هو الإختبارات الغير معلمية، وتتميز هذه الاختبارات الغير معلمية بأنها سهلة 

تجيب عليها    يوجد شروط معينة لتنفيذها ومن الجدير بالذكر أن هناك الكثير من التساؤلات التي لا

 .الاختبارات المعلمية مثل الاسئلة التي تتعلق بترتيب قيم البيانات وليس القيم نفسها

 :  Mann – Whitneyويتني -أولا: اختبار مان

عدم  ويتنى هو الإختبار اللامعلمى البديل لإختبار )ت( لعينتين مستقلتين، فى حالة –يعد اختبار مان   

 .توافر شروط الإختبار المعلمى

 تطبيقي:  مثال

وجامعة   فيما يلى بيان بدرجات مجموعة من الطلاب فى مادة المحاسبة، فى كل من جامعة الوادي 

 :بسكرة

 :درجات مادة المحاسبة بكلية التجارة جامعة الوادي 

16 8 7 14 10 

7 14 15 7 3 

 

  :درجات مادة المحاسبة بكلية التجارة جامعة بسكرة

3 12 5 6 13 

14 10 10 11 10 

 

 المطلوب: 

 طلاب  ويتنى: إختبر هل هناك إختلاف فى متوسط درجات مادة المحاسبة بين –بإستخدام إختبار مان  

    %5جامعة الوادي وطلاب جامعة بسكرة، وذلك عند مستوى معنوية 

 خطوات الحل: 

 كتابة فرضية الاختبار وهي: .1

2= u 1: u0H 
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2≠ u 1:  u1H 

 حيث أن:

1U متوسط درجات طلاب جامعة الوادي 

2U  متوسط درجات طلاب جامعة بسكرة 

والذي مثل فيه طلاب الوادي   Group  ادخال البيانات وتسمية المتغير الأول ب  .2

الذي يشمل  grades ( وتسمية المتغير الثاني ب 2( وطلاب بسكرة بالرقم )1بالرقم )

 درجات مادة المحاسبة لكل من طلاب  الوادي وطلاب بسكرة 

 وللقيام بهذا الاختبار في البرنامج نتبع الخطوات التالية:

Analyze → Nonparametric test → legacy dialogs        2 Independent sample  

 فيظهر لنا مربع الحوار كما يلي:

 
 فيظهر لنا مربع الحوار التالي: define groupثم نضغط على 
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كما هو موضح في الشكل أعلاه ثم نضغط    group2بجانب  2والرقم  group1بجانب  1حيث نكتب 

فتظهر النتائج كما في الجدول   okفيتم الرجوع الى الشكل السابق ثم نضغط على  continueعلى 

 التالي:

 

  5أكبر من مستوى المعنوية  وهي    0.648تساوى  وهي    P.Value  يلاحظ من نتائج هذا الإختبار: أن قيمة

جامعة    %، التجارة  كلية  فى  المحاسبة  مادة  درجات  متوسط  بأن  العدمى  الفرض  نقبل  فاننا  وبالتالى 

بسكرة، أى أن الفروق بين الجامعتين غير   الوادي يساوى متوسط درجات مادة المحاسبة فى جامعة

 .معنوية

 : السؤال الآن

الفرض   وليس  البديل  الفرض  قبلنا  قد  اننا  بمعنى   ( معنوية  الجامعتين  بين  الفروق  كانت  لو  ماذا 

 العدمي(

في هذه الحالة نقوم بالمقارنة بين متوسط الرتب للعينتين، بحيث اذا كان متوسط رتب العينة الأولى  

)جامعة الوادي( أكبر من متوسط رتب العينة الثانية )جامعة بسكرة( فهذا يعني أن متوسط درجات  

بسكرة   جامعة  في  المحاسبة  مادة  متوسط  من  أكبر  يكون  الواد  جامعة  في  المحاسبة  )باحتمال  مادة 

p.value/2.والعكس صحيح ) 

 :  Wilcoxon Testثانيا: اختبار ولكوكسون  

حالة  فييعد اختبار ولكوكسون هو الإختبار اللامعلمى البديل لإختبار )ت( لعينتين غير مستقلتين، 

 .عدم توافر شروط الإختبار المعلمى
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 تطبيقي:   مثال

 تأثير ممارسة الرياضة على انقاص الوزن: 

 98 103 88 90 95 80 96 85 الوزن قبل ممارسة الرياضة

 86 84 80 75 82 85 85 80 الوزن بعد ممارسة الرياضة

 المطلوب: 

 Wilcoxon إختبار هل هناك إختلاف معنوى فى الوزن بسبب ممارسة الرياضة، بإستخدام إختبار

 ؟ . 5 %عند مستوى معنوية 

 خطوات الحل: 

 كتابة الفرضية:  .1

2= u 1: u0H 

2≠ u 1:  u1H 

 حيث أن:

1U متوسط الوزن قبل الرياضة 

2U متوسط الوزن بعد الرياضة 

 ادخال البيانات وتسمية المتغيرات قبل وبعد  .2

 وللقيام بهذا الاختبار في البرنامج نتبع الخطوات التالية:

Analyze → Nonparametric test → legacy dialogs        2 Related sample  

 :فيظهر لنا مربع الحوار كما يلي

 
ثم قم بنقل هذين المتغيرين الى المربع الذي    Afterثم على المتغير  befor اضغط  مرة واحدة على المتغير  

 وذلك من خلال الضغط على السهم الصغير الموجود بين المربعين Test Pair(s) Listبعنوان 
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إختبار هو  البرنامج  جانب  من  الإفتراض ى  الإختيار  أن  أمامك:  الذى  الحوارى  المربع  نفس  فى   لاحظ 

Wilcoxon وهو الإختبار الذى نريده لذا سنتركة كما هو. 

 فتظهر النتائج كما في الجدول التالي:  okثم نضغط على 

 
 

 ق على أساس: قام البرنامج بحساب الفرو  •

 . الوزن قبل ممارسة الرياضة –الفرق = الوزن بعد ممارسة الرياضة  

(   (1.5 ( أكبر من متوسط الرتب الموجبة  4.93أن متوسط الرتب السالبة )  –أيضا   –ويلاحظ  •

ممارسة الرياضة أكبر من متوسط الوزن بعد ممارسة   هذا معناه أن متوسط الوزن قبل

 .(للعينتين )إذا فى غاية الأهمية أن نعرف الترتيب الذى إستخدمه البرنامج   الرياضة

 0.05وهي أقل من مستوى المعنوية  0.021تساوي   P.Valueيلاحظ من نتائج هذا الاحتبار أن قيمة 

عن   معنويا  يختلف  الرياضة  ممارسة  قبل  الوزن  متوسط  بأن  البديل  الفرض  نقبل  فاننا  وبالتالي 

 متوسط الوزن بعد ممارسة الرياضة 

 تحديد اتجاه العلاقة:لو 

السالبة أكبر   نقارن بين متوسط رتب الإشارات الموجبة والسالبة، ويلاحظ أن متوسط رتب الإشارات

أقل من    لإشارات الموجبة، مما يدل على أن متوسط الوزن بعد ممارسة الرياضةا من متوسط

 = P.Value ÷ 2= 0.0105 .متوسط الوزن قبل ممارسة الرياضة، وذلك بإحتمال 
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 الخطي واللوجستي  تحليل الارتباط والانحدار .4

 تحليل الارتباط:.1.4

يستخدم تحليل الارتباط في تقدير درجة الارتباط الخطي )مدى وجود علاقة خطية( بين متغيرين، 

( والاشارة الموجبة )+( تعني ان 1-( و )1واتجاه هذه العلاقة وتتراوح قيمة معامل الارتباط بين )+ 

 ( فتعني ان العلاقة عكسية بين المتغيرين.-العلاقة طردية اما الإشارة السالبة )

 ثلاثة مقاييس لمعامل الارتباط: SPSSيقدم برنامج 

من المقاييس المعلمية الذي يستخدم في حالة المتغيرات  :  Pearsonمعامل ارتباط بيرسون  •

 الكمية.

: من المقاييس اللامعلمية التي تستخدم Spearman' s rhoمعامل ارتباط سبيرمان للرتب  •

 في حالة المقاييس الترتيبية. 

 كما هو الحال في معامل ارتباط سبيرمان. :  Kendall 's tauمعامل كندال للرتب  •

 Pearsonأولا:معامل ارتباط بيرسون  

 تطبيقي:  مثال

 لتكن لدينا البيانات المتوافرة في الجدول التالي الخاصة بالدخل والادخار: 

 الادخار  الدخل 

100 15 

120 10 

150 30 

180 40 

200 45 

210 20 

190 80 

400 50 

250 100 

350 60 

600 90 
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 المطلوب: 

 حساب معامل الارتباط بيرسون بين كل من الدخل والادخار •

 . %5اختبار معنوية معامل الارتباط عند مستوى معنوية  •

 خطوات الحل: 

 كتابة الفرضية:  .1

H0: p = 0 

H1:  p ≠ 0 

 حيث أن:

 معامل الارتباط بين الدخل والادخار غير معنوي  0Hالفرض العدمي   ✓

 معامل الارتباط بين الدخل والادخار معنوي  1Hالفرض البديل  ✓

 

 نقوم بإدخال البيانات وتسميتها .2

 بعد ادخال البيانات نقوم باتباع المسار:  .3

Analyze → correlate→ Bivariate         

 

 فيظهر لنا مربع الحوار التالي:

 
 ربع الحواري نقوم بما يلي: في الم

 Variablesننقل كل من الدخل والادخار الى المربع الذي بعنوان  •

 ان الاختيار الافتراض ي لمعامل الارتباط هو معامل ارتباط بيرسون سنتركه كما هو  •

أيضا  Two−tailedكما ان الاختيار الافتراض ي لاختبار المعنوية هو الاختبار من طرفين  •

 سنتركه كما هو 
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 . سوف تظهر لنا النافذة الخاصة بمخرجات هذا الاختبار Okثم نضغط  •

( كما نلاحظ أيضا  0.617يتضح لنا من الجدول السابق أن هناك ارتباط طردي بين الدخل والاستهلاك )

قيمة   المعنوية    0.043  تساوي   P.Valueان  مستوى  من  اقل  الفرض    0.05وهي  نرفض  فاننا  وبالتالي 

العدمي ونقبل الفرض البديل القائل بأن علاقة الارتباط بين المتغيرين ) الدخل والادخار( تختلف عن  

 الصفر أي ان علاقة الارتباط معنوية 

 Spearman' s rhoثانيا: معامل ارتباط سبيرمان للرتب 

 : 2مثال

فيما يلي بيان بالتقديرات الخاصة بعشرة طلاب  لكلية الاقتصاد بجامعة الوادي في مقياس ي 

 المحاسبة والاحصاء: 
 تقديرات مقياس الاحصاء  تقديرات مقياس المحاسبة

 مقبول  جيد

 مقبول  مقبول 

 ضعيف جدا جيد جدا 

 جيد جدا  ضعيف 

 مقبول  جيد

 جيد جيد

 مقبول  ممتاز 

 جيد جدا  ضعيف جدا 

 مقبول  مقبول 

 مقبول  جيد

 المطلوب: 

 حساب معامل ارتباط سبيرمان للرتب  •
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 .٪ 5اختبار معنوية معامل الارتباط وذلك عند مستوى معنوية  •

 خطوات الحل: 

 كتابة الفرضية:  .1

H0: p = 0 

H1:  p ≠ 0 

 حيث أن:

 معامل الارتباط بين الرتب غير معنوي  0Hالفرض العدمي   ✓

 معامل الارتباط بين الرتب معنوي  1Hالفرض البديل  ✓

 نقوم بتكويد التقديرات السابقة كما يلي:  .2

 ضعيف جدا  ضعيف مقبول  جيد  جيد جدا  ممتاز التقدير

 1 2 3 4 5 6 الكود

 نقوم بادخال البيانات:  .3

 نتبع المسار التالي:  .4

Analyze → correlate→ Bivariate         

 سوف يظهر مربع الحوار التالي:

 
 

 Variablesننقل كل من تقديرات الإحصاء وتقديرات المحاسبة الى المربع الذي بعنوان  •

 لأننا نريد اظهار نتائج اختبار بيرسون   Pearsonنقوم بتعطيل الاختبار  •
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 Spearmanنقوم بتنشيط اختبار  •

أيضا  Two−tailedكما ان الاختيار الافتراض ي لاختبار المعنوية هو الاختبار من طرفين  •

 سنتركه كما هو 

 سوف تظهر النتائج كما يلي: Okثم نضغط  •

 
والاحصاء   المحاسبة  مقياس ي  درجات  بين  عكس ي  ارتباط  هناك  ان  السابق  الجدول  من  لنا  يتضح 

وبالتالي    0.05وهي اقل من مستوى المعنوية    0.027  تساوي   P.Valueكما يلاحظ أيضا ان قيمة    (0.692)

 فاننا نرفض الفرض العدمي ونقبل الفرض البديل أي ان علاقة الارتباط معنوية. 

 : Correlation Matrix ثالثا: مصفوفة الارتباط 

 هي مصفوفة تتضمن معاملات ارتباط لاكثر من متغيرين.

 مثال: 

 لدينا المتغيرات التالية:

X1 X2 X3 X4 

12 35 10 24 

20 20 8 18 

15 45 5 10 

4 60 14 6 

11 33 12 16 

14 50 11 17 

25 36 15 11 

16 25 18 10 

14 44 20 15 
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24 15 4 25 

14 15 11 33 

 

 المطلوب: 

 اعداد مصفوفة الارتباط للمتغيرات التالية 

 خطوات الحل: 

 ادخال المتغيرات   .1

 نتبع المسار التالي:  .2

Analyze → correlate→ Bivariate         

 

 فيظهر مربع الحوار التالي:

 

 Variablesننقل كل المتغيرات الى المربع الذي بعنوان  .3

فقط وهذا يعني أن معاملات الارتباط التي   Pearsonنقوم بتنشيط الاختبار  .4

 ستظهر في المصفوفة هي معاملات ارتباط بيرسون 

  Two−tailedكما ان الاختيار الافتراض ي لاختبار المعنوية هو الاختبار من طرفين  .5

 أيضا سنتركه كما هو 

 سوف تظهر النتائج كما يلي: Okثم نضغط  .6
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حيث أن قيمة   X4و  X2وبين   X2 و   x1نلاحظ من النتائج السابقة معنوية معامل الارتباط بين 

P.Value  فيما عدا ذلك كانت  0.05في الحالتين أقل منP.Value   لجميع معاملات الارتباط اكبر من

 مما يعني ان علاقات الارتباط بين هذه المتغيرات غير معنوية.   0.05مستوى المعنوية 

 تحليل الانحدارالخطي واللوجستي:  .2.4

الانحدار تحليل  حيث   (Regression Analysis) يعد  شيوعًا،  وأكثرها  الإحصائية  الأدوات  أقوى  من 

أكثر. بشكل أساس ي، يساعدنا الانحدار على نمذجة   أو  بين متغيرين  العلاقة  بفهم طبيعة  لنا  يسمح 

متغير مستقل واحد أو  نريد التنبؤ به أو تفسيره، و (Dependent Variable) متغير تابعالعلاقة بين  

 .نعتقد أنها تؤثر على المتغير التابع (Independent Variable/s) أكثر

 : في هذا الدرس، سنتناول 

يُستخدم عندما يكون المتغير   :(Simple Linear Regression) الانحدار الخطي البسيط  .1

(، مثل الدرجات، الدخل، أو الوزن
ً

 ومتغير مستقل واحد. .التابع كميًا )متصلا

يستخدم في حال كان لدينا   : (Multiple Linear Regressionالانحدار الخطي المتعدد )  .2

 أكثر من متغير مستقل. 

يُستخدم عندما يكون المتغير التابع فئويًا   :(Logistic Regression) الانحدار اللوجستي  .3

( ويأخذ قيمتين فقط، مثل )ناجح/راسب(، )مريض/سليم(، أو )يشتري/لا يشتري(
ً
 .)اسميا
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 ( Simple Linear Regressionأولا: الانحدار الخطي البسيط )

الانحدار الخطي البسيط هو أسلوب إحصائي يهدف إلى إيجاد أفضل خط مستقيم يمثل العلاقة 

(. يمكن استخدام هذا الخط للتنبؤ بقيمة المتغير التابع بناءً  Y( ومتغير تابع )Xبين متغير مستقل ) 

 على قيمة المتغير المستقل.

 مثال تطبيقي: 

يرغب مدير قسم التسويق في إحدى الشركات في معرفة ما إذا كانت هناك علاقة بين المبلغ المنفق  

يريد  فهو  موجودة،  العلاقة  كانت  إذا  )بالآلاف(.  المبيعات  وحجم  )بالآلاف(  الإعلانات  على 

 استخدامها للتنبؤ بالمبيعات المستقبلية. 

 بيانات المثال: 

 حملات إعلانية:  10لدينا البيانات التالية لآخر  

 (Y) المبيعات (X) الانفاق الإعلاني 

23 651 

26 762 

30 856 

34 1063 

43 1190 

48 1298 

52 1421 

57 1440 

58 1518 

 

 :المطلوب

 .اختبار وجود علاقة خطية معنوية بين الإنفاق الإعلاني والمبيعات .1

 .إيجاد معادلة خط الانحدار للتنبؤ بالمبيعات .2

 :SPSS خطوات الحل باستخدام

 :إدخال البيانات .1

 :Variable View قم بتعريف متغيرين في شاشة •
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 .Numeric )الإنفاق الإعلاني(، ونوعه Advertising الأول باسم •

 .Numeric )المبيعات(، ونوعه Sales الثاني باسم •

 .وأدخل البيانات كما في الجدول أعلاه Data View انتقل إلى شاشة •

 :تنفيذ تحليل الانحدار .2

 ...Analyze → Regression → Linearمن القائمة الرئيسية، اتبع المسار التالي •

 :سيظهر لك مربع الحوار التالي •

 
 ( المتغير التابع)  Dependentإلى خانة  Sales قم بنقل متغير  •

 )المتغير المستقل(.  Independent(s)إلى خانة  Advertisingقم بنقل متغير  •

 لتظهر النتائج. OKاضغط على 
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 :ستظهر لك عدة جداول، أهمها

 :(Model Summary) أ. جدول ملخص النموذج

• R Square   التحد هنا : يدمعامل  أن 0.977  قيمته  يعني  التي    97.7  % هذا  التغيرات  من 

الإعلاني  الإنفاق  في  التغيرات  خلال  من  تفسيرها  يمكن  التابع(  )المتغير  المبيعات  في  تحدث 

 .)المتغير المستقل(. وهي نسبة مرتفعة جدًا تدل على قوة النموذج

 :(ANOVA) ب. جدول تحليل التباين

• Sig  الدلالة نموذج الانحدار 0.05)أقل من     0.000 قيمته هنا :مستوى  أن  يدل على  (. هذا 

إحصائيًا ككل الإعلاني  معنوي  الإنفاق  بين  حقيقية  خطية  علاقة  بالفعل  هناك  أن  أي   ،

 .والمبيعات

 :(Coefficients) ج. جدول المعاملات

 .هذا الجدول هو الأهم لأنه يعطينا معادلة خط الانحدار 

•  (Constant): قيمة الثابت   ( نقطة تقاطع الخط مع المحور Y هي) :167,683 

• Advertising:  23.423 معامل المتغير المستقل )ميل الخط( هو 

 الاستنتاج وكتابة المعادلة:

 بما أن النموذج معنوي، يمكننا كتابة معادلة خط الانحدار:

 * الإنفاق الإعلاني( 23.423+ ) 167,683المبيعات = 

 التفسير: 
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ألف   23.423مقابل كل زيادة بمقدار ألف وحدة في الإنفاق الإعلاني، نتوقع أن تزيد المبيعات بمقدار 

 وحدة.

 167,683إذا كان الإنفاق الإعلاني صفرًا، نتوقع أن تكون المبيعات  

: الانحدار الخطي المتعدد
ً
 (Multiple Linear Regression) ثانيا

الانحدار الخطي المتعدد هو امتداد للانحدار البسيط. نستخدمه عندما نريد التنبؤ بمتغير تابع كمي  

 .واحد باستخدام متغيرين مستقلين أو أكثر

 للمعادلة:الصيغة العامة 

 Y = b₀ + b₁X₁ + b₂X₂ + ... + bₙXₙ 
   

 :مثال تطبيقي

يعتقد أن السعر لا يعتمد فقط  .سعر المنزل )بالآلاف(يريد مدير عقارات فهم العوامل التي تؤثر على  

 .عمر المنزل )بالسنوات(، ولكن أيضًا على مساحة المنزل )بالمتر المربع(على 

 :بيانات المثال

 (Age) عمر المنزل  (Area) مساحة المنزل  (Price) سعر المنزل 

250 150 10 

300 180 5 

220 140 15 

450 250 2 

380 220 3 

310 190 8 

200 120 20 

500 280 1 

 

 :المطلوب

 .بناء نموذج انحدار خطي متعدد للتنبؤ بسعر المنزل  .1

 .تحديد أي من المتغيرات )المساحة، العمر( له تأثير معنوي على السعر .2

 .تفسير النموذج .3

 :SPSS خطوات الحل باستخدام
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 .وأدخل البيانات (Price, Area, Age) متغيرات 3عرف  :أدخل البيانات .1

 :تنفيذ التحليل .2

 ....Analyze → Regression → Linear اذهب إلى .1

 فتظهر لنا مربع الحوار  

 
 .Dependent إلى خانة Price انقل .2

 من انقل .3
ً
 .Independent(s) إلى خانة  Age و Area كلا

 OK اضغط .4
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 :تفسير نتائج الانحدار المتعدد

 :(Model Summary) جدول ملخص النموذج 1 

•  R Square :من التغير في أسعار المنازل يمكن تفسيره   %99.7  هذا يعني أن 0.997  قيمته

 .بواسطة مساحة المنزل وعمره معًا

• Adjusted R Square (R Square)  :هذه القيمة مهمة جدًا في   0.995 قيمته :المعدل

تأخذ في الاعتبار عدد المتغيرات المستقلة في  R² الانحدار المتعدد. هي نسخة معدلة من

 .النموذج. نستخدمها لمقارنة النماذج التي تحتوي على أعداد مختلفة من المتغيرات

 :(ANOVA) جدول تحليل التباين.  2

• : Sig  ( هذا يؤكد أن النموذج ككل )باستخدام المساحة والعمر  0.05)أقل من  0.000  قيمته

 .معًا( هو نموذج جيد ومعنوي إحصائيًا للتنبؤ بالسعر

 :(Coefficients) جدول المعاملات  3 .

 .هذا هو الجدول الرئيس ي لتفسير تأثير كل متغير على حدة

 :Sig عمود •

• ) Areaقيمة) :المساحة Sig. للمساحة   ، فإن0.05 بما أنها اصغر من  .0.000  هي

 .على السعر تأثيرًا معنويًا

• Age  قيمة ): )العمر Sig. العمر ليس له تأثيرًا  فإن  0.05 بما أنها أكبر من  0.339 هي

 .على السعر معنويًا

 ) :)المعاملات غير المعيارية B   عمود •



 د/ باهي وف اء       SPSS التحليل الإحصائي للبيانات باستخدام برنامج الفصل الثاني:  

96 

 

• (Constant)   79.285: الثابت- 

• Area  متر مربع   هذا يعني أنه مع ثبات عمر المنزل، كل زيادة بمقدار =2.071  المعامل

 .ألف 2.071  في المساحة تؤدي إلى زيادة في السعر بمقدار واحد

•  Age لكنه غير معنوي أي ان عمر المنزل ليس له اثر على السعر  =1.171 المعامل 

 * المساحة(    1.531+ )  67.928سعر المنزل =  :كتابة المعادلة النهائية •

المتغير مساحة المنزل هو مؤشر مهم للتنبؤ بسعر المنزل. المساحة   :الاستنتاج النهائي •

 .، والنموذج ككل فعال جدًا في التنبؤأثرتزيد من السعر، بينما العمر ليس له 

: الانحدار اللوجستي
ً
 (Logistic Regression) ثالثا

يُستخدم الانحدار اللوجستي عندما يكون المتغير التابع اسميًا ذا فئتين )ثنائي(. الهدف ليس التنبؤ  

 .بقيمة رقمية، بل التنبؤ باحتمالية وقوع حدث معين

  : مثال تطبيقي

قام البنك بجمع بيانات عن   .تعثر العملاء في سداد القروضيريد بنك دراسة العوامل التي تؤدي إلى 

، تشمل  15
ً
 ( = تعثر 1لم يتعثر، = 0 ) حالة سداد القرض، وعمر العميلعميلا

 المطلوب: 

 .يعتبر مؤشرًا جيدًا للتنبؤ باحتمالية تعثر العميل عن السداد  العمر اختبار ما إذا كان •

 :SPSS خطوات الحل باستخدام

o إدخال البيانات: 

 )اسمي(  Default )رقمي( و Age :قم بتعريف متغيرين •

 ـ :وقم ب   Values ، اذهب إلى عمودDefault ، بالنسبة لمتغيرVariable View في شاشة  •

 .تعثر". هذا يساعد في قراءة النتائج" = 1  ،"لم يتعثر " = 0 :القيمتعريف  ❖

 Data View أدخل البيانات في شاشة •
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o  تنفيذ تحليل الانحدار اللوجستي: 

  :...Analyze → Regression → Binary Logistic من القائمة الرئيسية، اتبع المسار •

 :سيظهر لك مربع الحوار التالي

 
 Dependentإلى خانة  Default انقل متغير  •

 ( وهي تعادل المتغيرات المستقلة هنا )   Covariatesخانة إلى  Ageانقل متغير  •
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  OKاضغط على  •

 
o  تفسير النتائج: 

 :(Classification Table) جدول تصنيف الحالات .1

 73.3  يوضح هذا الجدول مدى دقة النموذج في التصنيف. هنا، استطاع النموذج تصنيف •

 .من الحالات بشكل صحيح %

 :(Variables in the Equation) جدول المتغيرات في المعادلة  .2

• Sig مستوى الدلالة( لمتغير( Age:  العمر  . هذا يعني أن0.05، وهي أقل من  0.043 القيمة هنا

 .على احتمالية تعثر العميل له تأثير معنوي إحصائيًا

• ) B قيمة المعامل للمتغير ): المعامل Age     كلما   بما أنها قيمة موجبة، فهذا يعني أنه 0.176هي

 .زاد عمر العميل، زادت احتمالية تعثره عن السداد

• Exp(B) (  الأرجحيةالنسبة: (Odds Ratio-    يمكن تفسيرها كالتالي: مقابل كل   1.192قيمتها

 .مرة 1.192زيادة بمقدار سنة واحدة في العمر، تتضاعف أرجحية التعثر بمقدار 

، يمكننا القول بأن العمر يُعد مؤشرًا مهمًا  (Sig < 0.05) بما أن تأثير العمر معنوي إحصائيًا :الاستنتاج

  للتنبؤ بحالة سداد القرض. العلاقة طردية، حيث تزداد احتمالية التعثر مع تقدم العمر بناءً على هذه 

 العينة.
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 العاملي والتصنيفي التحليل .5

في الكثير من الأبحاث، خاصة في العلوم الاجتماعية والنفسية والتسويقية، نتعامل مع عدد كبير من  

المتغيرات التي قد تكون مترابطة فيما بينها. التحليل العاملي والتصنيفي هما أسلوبان إحصائيان  

 .يساعدان الباحث على فهم البنية الكامنة وراء هذه المتغيرات وتصنيفها

: التحليل العاملي الاستكشافي 1.5
ً
 (Exploratory Factor Analysis) أولا

هو أسلوب لتخفيض البيانات    ( Exploratory Factor Analysis - EFAالتحليل العاملي الاستكشافي )

(Data Reduction  يُستخدم لتقليص عدد كبير من المتغيرات المترابطة إلى عدد أقل من .)  "العوامل"

يمكن اختصار    "الأبعاد"أو   المثال،  يمكن ملاحظتها مباشرة. على سبيل  التي لا  في    20الكامنة   
ً
سؤالا

( الرضا عن بيئة  2( الرضا عن الراتب، ) 1عوامل رئيسية فقط: )  3استبيان يقيس الرضا الوظيفي إلى  

 ( الرضا عن المهام الوظيفية. 3العمل، )

  :تطبيقيمثال 

  6قام باحث بتصميم استبيان لقياس "جودة الخدمات في أحد المستشفيات". الاستبيان يتكون من 

 :. العبارات هي5إلى  1عبارات، ويجيب عليها المريض على مقياس من 

•  V1 سرعة استجابة الممرضين. 

• V2 مهارة الممرضين في التعامل مع الحالات. 

•  V3نظافة الغرف والممرات. 

•  V4 جودة وتنوع الوجبات الغذائية. 

• V5 وضوح شرح الطبيب للحالة المرضية. 

•  V6الوقت الكافي الذي يمنحه الطبيب للمريض. 

يريد الباحث أن يعرف ما إذا كانت هذه العبارات الست يمكن تجميعها في عدد أقل من الأبعاد  

 .الرئيسية )العوامل(

 :المطلوب

 .إجراء تحليل عاملي استكشافي لاكتشاف العوامل الكامنة وراء جودة الخدمة •

 :SPSS خطوات الحل باستخدام
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 متغيرات 6مريض( في   30قم بإدخال بيانات الاستبيان لعينتك )لنفترض  :إدخال البيانات .1

V1)  إلىV6 ) 

 

 :تنفيذ التحليل العاملي .2

 من القائمة الرئيسية، اتبع المسار  .1

 Analyze → Dimension Reduction → Factor….. 

 Variables إلى خانة  V6)  إلى (V1 سيظهر لك مربع الحوار الرئيس ي. انقل جميع المتغيرات .2

 
 :ضبط الخيارات )وهي خطوة حاسمة( .3

 ) :الإحصاءات الوصفية Descriptives ( زر  .1
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هذا الاختبار يخبرنا ما إذا كانت بياناتنا   .KMO and Bartlett's test of sphericity  حدد •

 للتحليل العاملي
ً

 .مناسبة أصلا

 .Continue اضغط •

 ( : الاستخلاص Extraction (زر  .2

 
)المكونات الأساسية(، وهو   Principal components ، تأكد من اختيار Method في خانة •

 .الأسلوب الأكثر شيوعًا

 Correlation Matrix ، تأكد من اختيارAnalyze في قسم •

  Greater than 1 وأن تكون القيمة Based on Eigenvalue  ، حدد Extract في قسم •

 .هذا هو المعيار الافتراض ي والأكثر استخدامًا لتحديد عدد العوامل
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 .Continue اضغط •

 ( : التدوير)  Rotation زر   .3

 
 .، وهو أشهر أنواع التدوير المتعامدVarimax التدوير يجعل تفسير العوامل أسهل. حدد •

 .Continue اضغط •

 ( : تخيارا Options ( زر  .4

 
)لترتيب المتغيرات حسب   Sorted by size ، حددCoefficient Display Format في قسم •

)لإخفاء التشبعات الضعيفة(.  Suppress small coefficients تشبعها على العامل( و

لن   0.4هذا يعني أن أي تشبع أقل من  .Absolute value below في خانة 0.4 أدخل قيمة

 .يظهر، مما يسهل قراءة النتائج

 .Continue اضغط •

 .في مربع الحوار الرئيس ي لتظهر النتائج   OKاضغط  .4
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 تفسير نتائج التحليل العاملي

 ( الشيوع (Communalities جدول .  1

 
يوضح هذا الجدول نسبة التباين في كل عبارة من عبارات الاستبيان التي نجح نموذجنَا )المكون من  

 .عاملين( في تفسيرها

 :القاعدة العامة

 .العبارة جيدة ومناسبة للتحليل ⇒    Extraction ≥ 0.50إذا كانت قيمة  •

 .كلما كانت العبارة ممثلة بقوة داخل النموذج ⇒  1كلما اقتربت من  •

 

الشيوع المستخلص الممرضين" هي   (Extraction) قيمة  استجابة  أن 0.957لعبارة "سرعة  يعني  . هذا 

% من الاختلافات في إجابات المرض ى على هذه العبارة يمكن تفسيرها من خلال العاملين اللذين  95.7

(، مما يدل على أن الحل المكون 1استخلصناهما. نلاحظ أن جميع قيم الشيوع مرتفعة جدًا )أقرب إلى 

 .ومناسب جدًا للبيانات، حيث إنه يفسر معظم التباين في كل عبارة على حدةمن عاملين هو حل ممتاز  

 (Total Variance Explained) جدول التباين الكلي المفسر .2

يوضح هذا الجدول الأهمية النسبية لكل عامل من العوامل المستخلصة، ومقدار ما يفسره كل عامل  

 .من التباين الكلي في جميع المتغيرات

 
 :التي تهدف إلى تسهيل التفسير، نجد أن، (Rotation) التدويربعد عملية 

 .إجمالي التباين في البيانات من 48.06 % أصبح يفسر بمفرده العامل الأول  •

 .من إجمالي التباين   46.99  % أصبح يفسر بمفرده العامل الثاني •
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من التباين الكلي في إجابات  %  95.05نسبته ، أن العاملين معًا يفسران ما الأهم من ذلك •

المرض ى. هذه النسبة تعتبر نسبة تفسيرية ممتازة جدًا، وتدل على أن اختصار العبارات  

 .الست في هذين العاملين لم يؤدِ إلى فقدان الكثير من المعلومات المهمة

 ملاحظة : 

 التدوير لا يغيّر مجموع التباين، لكنه يوزّعه بين العوامل ليسهل التفسير.

 ( Rotated Component Matrix. جدول مصفوفة المكونات بعد التدوير )3

هذا هو الجدول الأهم على الإطلاق، فهو يمثل النتيجة النهائية للتحليل ويساعدنا على فهم محتوى  

 كل عامل وتسميته. يوضح هذا الجدول مدى ارتباط )تشبع( كل عبارة بكل عامل من العاملين.

 
 لماذا التدوير؟ 

 :لجعل

 كل عبارة ترتبط بعامل واحد بشكل أوضح •

 تسهيل تسمية العوامل  •

 :القاعدة

 (Loading) أعلى تحميلنربط العبارة بالعامل الذي لها فيه 

 :قراءة الجدول بعد التدوير

 :العامل الأول  

 التحميل  العبارة

 0.746 سرعة استجابة الممرضين 

 0.765 وضوح شرح الطبيب

 0.656 الوقت الكافي من الطبيب 
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 0.857 نظافة الغرف والممرات 

ز على
ّ
 التفاعل الطبي والبيئة العلاجية : هذا العامل يرك

 جودة الرعاية الطبية والبيئة العلاجية :1اسم مقترح للعامل 

 :العامل الثاني

 التحميل  العبارة  

 0.834 مهارة الممرضين 

 0.791 جودة وتنوع الوجبات 

 الخدمات المساندة والتمريضية  :هذا العامل يعبّر عن

 جودة الخدمات الداعمة للمريض  :2اسم مقترح للعامل 

 الخلاصة النهائية : 

مع   (PCA) أظهرت نتائج التحليل العاملي الاستكشافي باستخدام طريقة المكونات الرئيسية •

يفسران معًا  عاملين أساسيين أن استبيان جودة الخدمات يتكون من   Varimax تدوير

 .من التباين الكلي 95.045%

 .جميع العبارات أظهرت اشتراكيات مرتفعة، مما يدل على ملاءمتها للتحليل •

جودة  ، والعامل الثاني بـ جودة الرعاية الطبية والبيئة العلاجيةيمكن تسمية العامل الأول بـ   •

، مما يؤكد أن جودة الخدمات في المستشفى مفهوم متعدد الخدمات الداعمة للمريض

 .الأبعاد

 (Cluster Analysis) التحليل العنقوديثانيا:  .2.5

يختلف التحليل العنقودي عن التحليل العاملي في هدفه الأساس ي. فبينما يهدف التحليل العاملي إلى  

المتشابهة  المتغيرات  إلى  تجميع  العنقودي  التحليل  يهدف  المشاهدات(  ،  أو  )الأفراد  الحالات  تجميع 

إنه أسلوب تصنيفي قوي يُستخدم لتقسيم عينة غير متجانسة إلى عدد من المجموعات أو   .المتشابهة

بحيث تكون الحالات داخل العنقود الواحد متشابهة جدًا فيما بينها، ومختلفة   (Clusters) ""العناقيد 

 .جدًا عن الحالات في العناقيد الأخرى 

شرائح   إلى  عملائها  لتقسيم  العنقودي  التحليل  استخدام  تسويق  لشركة  يمكن  المثال،  سبيل  على 

"العملاء الجدد"(،   الباحثون عن العروض"،  مختلفة )مثل: "العملاء ذوي الإنفاق المرتفع"، "العملاء 

 .ومن ثم توجيه استراتيجيات تسويقية مختلفة لكل شريحة

 مثال تطبيقي:  

 تصنيف عملاء شركة اتصالات
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تريد شركة اتصالات أن تفهم قاعدة عملائها بشكل أفضل لتقديم باقات وعروض مخصصة. قامت  

، بناءً على متغيرين رئيسيين 20الشركة بجمع بيانات عن عينة من 
ً
 :عميلا

•  minutes: متوسط عدد دقائق المكالمات الشهرية. 

• data:  )متوسط استهلاك بيانات الإنترنت شهريًا )بالجيجابايت. 

، قم بتقسيم  (Hierarchical Cluster Analysis) باستخدام التحليل العنقودي الهرمي :المطلوب

 .هؤلاء العملاء إلى مجموعات )عناقيد( متجانسة بناءً على سلوكهم في استهلاك الدقائق والبيانات

 خطوات الحل: 

o  ادخال البيانات 

سنستخدم التحليل العنقودي الهرمي لأنه لا يتطلب منا تحديد عدد العناقيد مسبقًا، بل يساعدنا  

 .على اكتشافه

 .data و  minutes ، قم بتعريف متغيرين Variable View في شاشة  .1

 
 

o   تنفيذ التحليل العنقودي الهرمي 

 ...Analyze → Classify → Hierarchical Clusterمن القائمة الرئيسية، اتبع المسار .1
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 .Variable(s) إلى خانة data و minutes سيظهر لك مربع الحوار. انقل المتغيرين .2

 
 .(لأننا نصنف الحالات/العملاء) Cases محدد على Cluster تأكد من أن الخيار .1

o   ضبط الخيارات 

 )الطريقة(.   Method ...اضغط على زر  •

 )طريقة وارد(.  Ward's method، اختر  Cluster Methodفي  •

 )المسافة الإقليدية المربعة(. Squared Euclidean distance، اختر Measureفي  •

 هذه هي الإعدادات القياسية والأكثر فعالية في معظم الحالات.  

 . Continueاضغط  •

 
 ( الرسوم البيانية)   ...Plots اضغط على زر  .2

هذا الرسم البياني الشجري هو أهم مخرج سيساعدنا على    .Dendrogram حدد خيار •

 .تحديد العدد الأمثل للعناقيد
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 .Continue اضغط •

 

o   تشغيل التحليل وحفظ العناقيد 

 (حفظ)  ...Save  اضغط على زر  .1

o حدد الخيار Single solution  (حل واحد ) 

o في خانة Number of clustersعند قراءة   3سنوضح لماذا اخترنا ) 3 ، اكتب الرقم

 (الرسم الشجري، ولكن لأغراض التطبيق، سنحددها الآن

o اضغط Continue. 

 .في مربع الحوار الرئيس ي لتشغيل التحليل OK اضغط .2
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o  :النتائج 

 
 

هذا الرسم هو الأداة البصرية الرئيسية التي تساعدنا على تحديد العدد الأمثل للعناقيد في بياناتنا.  

إنه يوضح لنا كيفية تجميع الحالات )العملاء في مثالنا( معًا بشكل تدريجي بناءً على درجة التشابه  

 .بينها

 :كيفية قراءة الرسم

 .20إلى  1يمثل كل الحالات الموجودة في العينة، مرقمة من  :(Y-axis) المحور الرأس ي •

 Rescaled Distance) "يمثل "المسافة المعاد قياسها لدمج العناقيد :(X-axis) المحور الأفقي •

Cluster Combine)    ببساطة، كلما تحركنا من اليسار إلى اليمين، زادت المسافة، مما يعني

 .أننا ندمج مجموعات أقل شبهًا ببعضها البعض

 .كل خط أفقي يمثل عملية دمج بين حالتين أو بين عنقودين :الخطوط •

أطول الخطوط  لتحديد العدد الأمثل للعناقيد، نبحث عن  :التحليل وتحديد عدد العناقيد

في الرسم، والتي تمثل "قفزات" كبيرة في المسافة قبل أن يتم دمج مجموعتين. هذه القفزات   الرأسية

 .تشير إلى أن المجموعتين اللتين سيتم دمجهما هما في الواقع مختلفتان تمامًا عن بعضهما البعض

انظر إلى الخط الرأس ي الطويل جدًا في أقص ى يمين الرسم )عند  :القفزة الأولى )الكبيرة( .1

تقريبًا(. هذا الخط يدمج كل الحالات في عنقود واحد كبير. هذا يشير إلى وجود   25مسافة 

 .على الأقل في البيانات عنقودين رئيسيين

  :القفزة الثانية )التالية في الطول( .2
ً
ا رأسيًا طويلا

ً
إذا نظرنا إلى العنقود السفلي، نجد خط

( ومجموعة 5, 20, 6, 16, 7تقريبًا( يفصل بين مجموعة من الحالات ) 15آخر )عند مسافة 

 .(14 ,17 ,13 ,12) أخرى 
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يمكننا   .عناقيد 3بناءً على الفحص البصري، فإن أوضح بنية للبيانات هي التي تفصلها إلى  :القرار

. هذا الخط سيقطع  20و  15تصور ذلك عن طريق رسم خط عمودي وهمي عند مسافة تقريبًا بين 

 :أماكن، مما ينتج عنه العناقيد الثلاثة التالية  3الرسم في 

وتنتهي بالحالة   3مجموعة كبيرة من الحالات تبدأ من الحالة رقم  :العنقود الأول )العلوي( •

 .11رقم 

 .12وتنتهي بـ  14مجموعة من الحالات تبدأ من  :العنقود الثاني )الأوسط( •

 .7وتنتهي بـ  5مجموعة الحالات الأخيرة التي تبدأ من  :العنقود الثالث )السفلي( •

هو الحل الأكثر   عناقيد 3الرسم الشجري يرشدنا بوضوح إلى أن الحل المكون من  :الاستنتاج

استقرارًا وذا معنى لهذه البيانات. إنه يوازن بين الحصول على عدد قليل من المجموعات يمكن إدارتها، 

 .مع الحفاظ على درجة عالية من التجانس داخل كل مجموعة

 فهم وتسمية العناقيد 

، ( CLU3_1بعد أن قمنا بحفظ عضوية كل عميل في أحد العناقيد الثلاثة )في متغير جديد اسمه  

يجب علينا الآن أن نفهم خصائص كل عنقود لنتمكن من تسميته. نقوم بذلك عن طريق حساب  

 .لكل عنقود data) و (minutes متوسطات متغيراتنا

 :الخطوات

 ....Analyze → Compare Means → Means اذهب إلى .1

 .Dependent List إلى قائمة  data و minutes انقل .2

 .Independent List إلى خانة CLU3_1  انقل متغير العنقود الجديد .3

 .OK اضغط .4

 
 :(Report) جدول النتائج

عناقيد، يقوم هذا التقرير بحساب متوسطات المتغيرات   3بعد أن حددنا أن الحل الأمثل هو 

لكل عنقود من العناقيد الثلاثة. من خلال مقارنة هذه المتوسطات،    (dataو  minutes) الأصلية

 .يمكننا فهم الخصائص الفريدة لكل مجموعة وتسميتها
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 تحليل وتسمية العناقيد 

 :لنرسم صورة واضحة لكل شريحة من شرائح العملاء بناءً على هذه المتوسطات

 ": "شريحة الاستخدام المتوازن 1العنقود   •

(. يتميزون   11يضم هذا العنقود أكبر عدد من العملاء )  :الخصائص •
ً
عميلا

متوسط   ومتوسط استهلاك دقيقة( 113منخفض للدقائق ) بمتوسط استهلاك

 .جيجا(  11.5للبيانات )

هؤلاء هم غالبية العملاء "العاديين" الذين يستخدمون هواتفهم بشكل   :التفسير •

 .متوازن لكل من المكالمات والإنترنت دون إفراط في أي منهما

 .عملاء الباقات المتوسطة أو شريحة الاستخدام المتوازن  :التسمية المقترحة •

 "(VIP) : "شريحة الاستخدام الكثيف2العنقود   •

مرتفع جدًا   عملاء. يتميزون بمتوسط استهلاك 5يضم هذا العنقود  :الخصائص •

 .جيجا( 28.2مرتفع جدًا للبيانات ) ومتوسط استهلاك دقيقة( 578للدقائق )

هؤلاء هم العملاء ذوو الاستخدام الأعلى على الإطلاق في كلا الخدمتين.  :التفسير •

 .يمثلون الشريحة الأكثر ربحية للشركة

العملاء ذوو القيمة   أو (VIP) شريحة الاستخدام الكثيف :التسمية المقترحة •

 .العالية

 ": "شريحة عشاق المكالمات3العنقود   •
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مرتفع   عملاء. يتميزون بمتوسط استهلاك 4يضم هذا العنقود  :الخصائص •

منخفض   ، ولكن في المقابل، متوسط استهلاكهم للبياناتدقيقة( 480للدقائق )

 .جيجا( 5جدًا )

هذا النمط واضح جدًا. هؤلاء العملاء يستخدمون هواتفهم بشكل أساس ي  :التفسير •

 .لإجراء المكالمات الصوتية الطويلة، واهتمامهم بخدمات الإنترنت محدود

 .عملاء باقات الدقائق أو شريحة عشاق المكالمات :التسمية المقترحة •

 الاستنتاج النهائي : 

ثلاث شرائح واضحة لقد نجح التحليل العنقودي في تقسيم عينة العملاء غير المتجانسة إلى 

 :هذه النتيجة تمكن شركة الاتصالات من .ومختلفة تمامًا في سلوكها الاستهلاكي

 من النظر إلى جميع العملاء بنفس الطريقة، يمكن للشركة الآن رؤية ثلاثة   :فهم السوق  .1
ً
بدلا

 .أنواع مختلفة من الاحتياجات

، 3يمكن تصميم باقات خاصة لكل شريحة )باقات دقائق للعنقود  :تخصيص العروض .2

 .(2، وباقات شاملة فاخرة للعنقود 1باقات بيانات وإنترنت للعنقود 

من خلال تلبية احتياجات كل شريحة بدقة، تزيد الشركة من رضا عملائها   :زيادة الولاء .3

 .وولائهم

هذه القراءة للنتائج شاملة وتوضح القوة العملية للتحليل العنقودي في اتخاذ قرارات عمل حقيقية 
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  الخاتمة:

مج دعم  ابر برنامجين مهمين يعتبران من أهم  استكشاف    لقد حاولنا من خلال هذه المطبوعة

المو القرار   هذه  من  الأساس ي  الهدف  كان  المجردة،    طبوعةلقد  والمعادلات  النظرية  حدود  تجاوز  هو 

 .والانطلاق نحو التطبيق العملي الذي يلامس واقع المشاكل التي تواجهها المؤسسات الاقتصادية اليوم

سواء كانت تتعلق بتعظيم —في الفصل الأول، تعلمنا كيف نترجم المشاكل الإدارية المعقدة

إلى  —الأرباح، أو تخفيض تكاليف النقل، أو جدولة المشاريع، أو حتى اتخاذ قرارات في بيئة تنافسية

، ببساطته وقوته، يمكننا من الوصول إلى WinQSB   نماذج كمية واضحة. لقد رأينا كيف أن برنامج

 لنا الفرصة للتركيز على  
ً
 إيانا من عبء الحسابات اليدوية ومعطيا

ً
الحلول المثلى بكفاءة وسرعة، محررا

 .تحليل النتائج وفهم أبعادها الاستراتيجية

 إلى البيانات الخام نفسها.  
ً
أما في الفصل الثاني، فقد حوّلنا انتباهنا من النماذج المحددة مسبقا

كيف نصغي إلى القصص التي ترويها البيانات. بدأنا بتنظيمها وتعريفها،  SPSS تعلمنا من خلال برنامج 

الاستدلالي،  الإحصاء  خلال  من  فرضياتنا  واختبرنا  الوصفي،  الإحصاء  عبر  تلخيصها  إلى  انتقلنا  ثم 

الظواهر   تبسيط  إلى   
ً
وصولا والانحدار،  الارتباط  تحليلات  عبر  المتغيرات  بين  العلاقات  عن  وبحثنا 

 .خلال التحليل العاملي والتصنيفيالمعقدة من 

إن إتقان استخدام هاتين البرمجيتين ليس مجرد مهارة تقنية، بل هو تغيير في طريقة التفكير. 

إنه يمثل الانتقال من متخذ قرار يعتمد على الحدس، إلى محلل وصانع قرار يعتمد على الأدلة والبيانات  

مجالات المالية والتجارة  والنماذج العلمية. هذه هي المهارة الجوهرية التي يتطلبها سوق العمل الحديث في  

 .الدولية وغيرها من التخصصات الإدارية والاقتصادية

 



 مراجعال

114 

 

 جع:  المرا 

التحليل الاحصائي للمتغيرات المتعددة باستخدام برنامج  أسامة ربيع أمين سليمان،   •

SPSS جامعة المنوفية قسم الإحصاء والرياضيات والتأمين.2008،القاهرة يوليو ، 

، المكتبة  2007، الطبعة الثانية  spssالتحليل الاحصائي باستخدام برنامج اسامة ربيع أمين،    •

 الاكاديمية القاهرة، مصر. 

ه، 1434م/ 2013، الطبعة الأولى spssتحليل البرنامج الاحصائي  إيهاب عبد السلام محمود،  •

 دار صفاء للنشر والتوزيع 

مقدمة لطلبة الماستر تخصص اقتصاد وتسيير المؤسسات  بوعراب رابح، مطبوعة بيداغوجية   •

 .2019/ 2018، 3، جامعة الجزائر SPSSدروس وتطبيقات متقدمة في برنامج  :بعنوان

 ،كلية البصرة الجامعة للعلوم والتكنولوجياالنظام الكمي للأعمال، ، حسن عوده عبد اللهقناة  •

YouTube ،IeGtI-https://www.youtube.com/watch?v=NCyg_   

، الأدوات الإحصائية لتحليل البيانات، مطبوعة دروس موجهة للسنة الثالثة  لطفي مخزومي •

 . 2022/ 2021، جامعة الوادي، محاسبة وجباية

، كلية شط العرب  QSBالنظام الكمي للأعمال ) أساليب بحوث العمليات( محمد عبود طاهر،   •

 الجامعة

 .2009، جانفي  linear programing by WINQSBمروان عبد الحميد عاشور، جامعة بغداد،  •

 Operations Research: An) بحوث العمليات: مدخل تطبيقي .(2017) .طه، حمدي أ •

Introduction). 

تطبيقات وتحليلات  مروان عبد الحميد عاشور، عمر محمد ناصر العشاري، خالد ضاري،  •

https://www.researchgate.net/profile/Marwan-متاح على الرابط  WINQSBالنظام الكمي للاعمال  

-Ashour/publication/316995982_linear_programming_by_Win_QSB/links/591cc6e245851540595a8cf7/linear

QSB.pdf-Win-by-rogrammingp 

• Field, A. (2018). Discovering Statistics Using IBM SPSS Statistics. Sage 

Publications 

• Hillier, F. S., & Lieberman, G. J. (2015). Introduction to Operations Research. 

McGraw-Hill Education 

• Pallant, J. (2020). SPSS Survival Manual: A Step by Step Guide to Data Analysis 

using IBM SPSS. Routledge . 

https://www.youtube.com/watch?v=NCyg_-IeGtI
https://www.researchgate.net/profile/Marwan-Ashour/publication/316995982_linear_programming_by_Win_QSB/links/591cc6e245851540595a8cf7/linear-programming-by-Win-QSB.pdf
https://www.researchgate.net/profile/Marwan-Ashour/publication/316995982_linear_programming_by_Win_QSB/links/591cc6e245851540595a8cf7/linear-programming-by-Win-QSB.pdf
https://www.researchgate.net/profile/Marwan-Ashour/publication/316995982_linear_programming_by_Win_QSB/links/591cc6e245851540595a8cf7/linear-programming-by-Win-QSB.pdf

